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is free software; you can redistribute it and/or modify it under the terms of the GNU
Lesser General Public License as published by the Free Software Foundation; either
version 2.1 of the License, or (at your option) any later version. This library is distributed
in the hope that it will be useful,but WITHOUT ANY WARRANTY; without even the implied
warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
Lesser General Public License for more details. You should have received a copy of the
GNU Lesser General Public License along with this library; if not, write to the Free
Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA.
unRAR copyright: The decompression engine for RAR archives was developed using source
code of unRAR program.All copyrights to original unRAR code are owned by Alexander
Roshal. unRAR License: The unRAR sources cannot be used to re-create the RAR
compression algorithm, which is proprietary. Distribution of modified unRAR sources in
separate form or as a part of other software is permitted, provided that it is clearly stated
in the documentation and source comments that the code may not be used to develop a
RAR (WinRAR) compatible archiver. 7-zip Availability: http://www.7-zip.org/

AMD Version 2.2 - AMD Notice: The AMD code was modified. Used by permission. AMD
copyright: AMD Version 2.2, Copyright © 2007 by Timothy A. Davis, Patrick R. Amestoy,
and Iain S. Duff. All Rights Reserved. AMD License: Your use or distribution of AMD or any
modified version of AMD implies that you agree to this License. This library is free
software; you can redistribute it and/or modify it under the terms of the GNU Lesser
General Public License as published by the Free Software Foundation; either version 2.1 of
the License, or (at your option) any later version. This library is distributed in the hope
that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser
General Public License for more details. You should have received a copy of the GNU
Lesser General Public License along with this library; if not, write to the Free Software
Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA Permission is
hereby granted to use or copy this program under the terms of the GNU LGPL, provided
that the Copyright, this License, and the Availability of the original version is retained on
all copies.User documentation of any code that uses this code or any modified version of
this code must cite the Copyright, this License, the Availability note, and "Used by
permission." Permission to modify the code and to distribute modified code is granted,
provided the Copyright, this License, and the Availability note are retained, and a notice
that the code was modified is included. AMD Availability:
http://www.cise.ufl.edu/research/sparse/amd

UMFPACK 5.0.2 - UMFPACK Notice: The UMFPACK code was modified. Used by permission.
UMFPACK Copyright: UMFPACK Copyright © 1995-2006 by Timothy A. Davis. All Rights
Reserved. UMFPACK License: Your use or distribution of UMFPACK or any modified version
of UMFPACK implies that you agree to this License. This library is free software; you can
redistribute it and/or modify it under the terms of the GNU Lesser General Public License
as published by the Free Software Foundation; either version 2.1 of the License, or (at
your option) any later version. This library is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY
or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for
more details. You should have received a copy of the GNU Lesser General Public License
along with this library; if not, write to the Free Software Foundation, Inc., 51 Franklin St,
Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby granted to use or copy this
program under the terms of the GNU LGPL, provided that the Copyright, this License, and
the Availability of the original version is retained on all copies. User documentation of any
code that uses this code or any modified version of this code must cite the Copyright, this
License, the Availability note, and "Used by permission." Permission to modify the code
and to distribute modified code is granted, provided the Copyright, this License, and the
Availability note are retained, and a notice that the code was modified is included.
UMFPACK Availability: http://www.cise.ufl.edu/research/sparse/umfpack  UMFPACK
(including versions 2.2.1 and earlier, in FORTRAN) is available at
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http://www.cise.ufl.edu/research/sparse . MA38 is available in the Harwell Subroutine
Library. This version of UMFPACK includes a modified form of COLAMD Version 2.0,
originally released on Jan. 31, 2000, also available at
http://www.cise.ufl.edu/research/sparse . COLAMD V2.0 is also incorporated as a built-in
function in MATLAB version 6.1, by The MathWorks, Inc. http://www.mathworks.com .
COLAMD V1.0 appears as a column-preordering in SuperLU (SuperLU is available at
http://www.netlib.org ). UMFPACK v4.0 is a built-in routine in MATLAB 6.5. UMFPACK v4.3
is a built-in routine in MATLAB 7.1.

Qt Version 4.6.3 - Qt Notice: The Qt code was modified. Used by permission. Qt copyright:
Qt Version 4.6.3, Copyright (c) 2010 by Nokia Corporation. All Rights Reserved. Qt
License: Your use or distribution of Qt or any modified version of Qt implies that you agree
to this License. This library is free software; you can redistribute it and/or modify it under
the
terms of the GNU Lesser General Public License as published by the Free Software
Foundation; either version 2.1 of the License, or (at your option) any later version. This
library is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY
or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for
more details. You should have received a copy of the GNU Lesser General Public License
along with this library; if not, write to the Free Software Foundation, Inc., 51 Franklin St,
Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby granted to use or copy this
program under the terms of the GNU LGPL, provided that the Copyright, this License, and
the Availability of the original version is retained on all copies.User
documentation of any code that uses this code or any modified version of this code must
cite the Copyright, this License, the Availability note, and "Used by permission."
Permission to modify the code and to distribute modified code is granted, provided the
Copyright, this License, and the Availability note are retained, and a notice that the code
was modified is included. Qt Availability: http://www.qtsoftware.com/downloads  Patches
Applied to Qt can be found in the installation at:
$HPEESOF_DIR/prod/licenses/thirdparty/qt/patches. You may also contact Brian
Buchanan at Agilent Inc. at brian_buchanan@agilent.com for more information.

The HiSIM_HV source code, and all copyrights, trade secrets or other intellectual property
rights in and to the source code, is owned by Hiroshima University and/or STARC.

Errata The ADS product may contain references to "HP" or "HPEESOF" such as in file
names and directory names. The business entity formerly known as "HP EEsof" is now part
of Agilent Technologies and is known as "Agilent EEsof". To avoid broken functionality and
to maintain backward compatibility for our customers, we did not change all the names
and labels that contain "HP" or "HPEESOF" references.

Warranty The material contained in this document is provided "as is", and is subject to
being changed, without notice, in future editions. Further, to the maximum extent
permitted by applicable law, Agilent disclaims all warranties, either express or implied,
with regard to this documentation and any information contained herein, including but not
limited to the implied warranties of merchantability and fitness for a particular purpose.
Agilent shall not be liable for errors or for incidental or consequential damages in
connection with the furnishing, use, or performance of this document or of any
information contained herein. Should Agilent and the user have a separate written
agreement with warranty terms covering the material in this document that conflict with
these terms, the warranty terms in the separate agreement shall control.

Technology Licenses The hardware and/or software described in this document are
furnished under a license and may be used or copied only in accordance with the terms of
such license. Portions of this product include the SystemC software licensed under Open
Source terms, which are available for download at http://systemc.org/ . This software is

http://www.cise.ufl.edu/research/sparse
http://www.cise.ufl.edu/research/sparse
http://www.cise.ufl.edu/research/sparse
http://www.cise.ufl.edu/research/sparse
http://www.mathworks.com
http://www.mathworks.com
http://www.netlib.org
http://www.netlib.org
http://www.qtsoftware.com/downloads
http://www.qtsoftware.com/downloads
http://systemc.org/
http://systemc.org/
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redistributed by Agilent. The Contributors of the SystemC software provide this software
"as is" and offer no warranty of any kind, express or implied, including without limitation
warranties or conditions or title and non-infringement, and implied warranties or
conditions merchantability and fitness for a particular purpose. Contributors shall not be
liable for any damages of any kind including without limitation direct, indirect, special,
incidental and consequential damages, such as lost profits. Any provisions that differ from
this disclaimer are offered by Agilent only.

Restricted Rights Legend U.S. Government Restricted Rights. Software and technical
data rights granted to the federal government include only those rights customarily
provided to end user customers. Agilent provides this customary commercial license in
Software and technical data pursuant to FAR 12.211 (Technical Data) and 12.212
(Computer Software) and, for the Department of Defense, DFARS 252.227-7015
(Technical Data - Commercial Items) and DFARS 227.7202-3 (Rights in Commercial
Computer Software or Computer Software Documentation).



Advanced Design System 2011.01 - UNIX and Linux Installation

6

  Before You Begin UNIX and Linux Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
  Check the System Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
  Obtain Licenses  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
  Back Up Data from Previous Installations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
  Check Available Memory   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
  Defining an Install Location  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
  Dataset Types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
  Supported Features on 64-bit Operating Systems  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
  Verifying Java (JRE) Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

  Installing Advanced Design System on UNIX and Linux  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
  Configuring User Accounts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
  Installing to Multiple Disk Partitions or Directories  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
  Using Multiple ADS Versions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
  Installing Connection Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

  Before Setting Up Licenses - Unix or Linux  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
  Obtaining Host Id/Hardware Key  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
  Obtaining the ADS License File  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
  License Types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

  ADS License Setup - Unix and Linux  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
  License Installation Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
  Get Host Id  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
  Obtain License File  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
  License Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
  Set Environment Variables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
  Launch ADS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

  Managing ADS Licenses - Unix or Linux  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
  License Information Tool  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
  License Preference Tool  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
  Special Licensing Needs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
  Managing Multiple ADS Versions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

  Using Advanced Design System  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
  Running Advanced Design System   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
  Using 32-bit Simulators on a 64-bit Operating System  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
  Using a Remote Display  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
    If ADS Does Not Start  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
  Printing and Plotting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
  Agilent EEsof Technical Support  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

  Troubleshooting and FAQs - Unix or Linux  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
    If ADS Does Not Start  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
  Common Licensing Problems  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
  Printing and Plotting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
  Agilent EEsof Technical Support  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

  Installing Connection Manager Server for UNIX and Linux  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
 



Advanced Design System 2011.01 - UNIX and Linux Installation

7

 Before You Begin UNIX and Linux
Installation
Before starting the Advanced Design System (ADS) Installation on Unix or Linux platform,
read the guidelines provided in the following sections.

  

 Check the System Requirements
 
Ensure that your hardware and software configuration meets the following minimum
hardware and system requirements to install and/or run ADS.

Note
Agilent recommends you to have more than the minimum configuration to effectively work with ADS.

 System Requirements
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Requirement Solaris (on SPARC) Linux

32-bit Operating System
(see "Operating Systems
Details")

Solaris 10 05/08 Patch Bundle or
the Solaris 10 05/08 (Update 5)
release image with 138352-02
 X11 6.6.2: fontconfig patch

Redhat RHEL WS 4.x, Redhat RHEL WS
5.x,Novell SUSE SLES 10

64-bit Operating System
(see "Supported Features
on 64-bit Operating
Systems")

Solaris 10 with 64-bit support
turned on
Solaris 10 05/08 Patch Bundle or
the Solaris 10 05/08 (Update 5)
release image with 138352-02
 X11 6.6.2: fontconfig patch

Redhat RHEL WS 4.x,Redhat RHEL WS 5.x,
Novell SUSE SLES 10 (64-bit AMD Opteron and
Intel EM64T processors)

Displays High-resolution color only. (Super VGA, 1024x768, 15-inch monitor minimum)

Processor ADS is not supported on Intel
Itanium-based workstations.

Intel Pentium® 4 or better, or AMD XP 3000 or
better.

RAM 1 GB RAM recommended minimum. Additional RAM will enable you to simulate
larger designs. However, on a 32-bit operating system, its processes cannot use
more than 2 GB regardless of the maximum addressable memory available on your
system.

Swap Space 512 MB recommended minimum, increased swap space may be required for larger
designs.

Web Browser ADS documentation is HTML-based and displayed via a web browser. Netscape 4.5
or higher is required.
Mozilla Firefox 5.5 or better are the recommended web browsers. To view the pdf
files, Acrobat Reader 5.0 or higher is recommended.
The minimum recommended version is Sun Java Plug-in 1.3 for searchability.
To use the documentation search engine on 64-bit Novell SUSE SLES 10 systems,
32-bit Mozilla from SuSe (mozilla-1.7.8-5.13.i586.rpm) and the 32-bit JRE 1.6.9_3
from Sun (jre-6u3-linux-i586.rpm) is required.

Hard Disk Space 1.3 GB for a minimum installation and 4.5 GB for complete installation.

Security Device ADS software licenses are
secured to a network server
using FLEXlm server software or
locked to an individual computer
host ID number.

ADS software licenses are secured to a network
server using FLEXlm server software or locked
to an external device (FLEXid hardware security
key) attached to the USB port (only applies to
32-bit code) or locked to a LAN ethernet card.

Supported Printers ADS uses Xprinter for all PostScript®, HPGL2 and PCL printing. For a complete list
of output devices supported with Xprinter, consult the text file called
filename_map.txt, located in the directory path: /xprinter/ppds. For instructions on
UNIX and Linux printing and plotting, refer to "Printing and Plotting".

Internet High speed internet access required to download ADS install files. You can also
check latest documentation and release updates at Agilent EEsof website.

Window Manager Motif™ V.1.1/1.2 Open Windows
3.0, or CDE

KDE or GNOME

Compiler (required only
for model development)
(see "User Complied
Models")

C+\+ and CC:
SunStudio 11

C++:
gcc Version 4.4.2

HDL simulator (required
only for HDL
cosimulation)

These HDL simulators are the latest versions supported on ADS:
- Mentor Graphics ModelSim SE Plus 6.3a (both 32-bit and 64-bit mode)
- Cadence NCSim IUS6.2 for both 64-bit and 32-bit simulation (Only on ADS
supported Linux and Sun).
- Cadence VerilogXL IUS6.2 for only 32-bit simulation (Only on ADS supported
Linux and Sun).
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 Operating Systems Details

Solaris Details Solaris operating systems are not supported on Intel-compatible chips.
Solaris requires the following patches (exact patch numbers may change as new patches
are issued):
You can find patches at http://sunsolve.sun.com/pub-cgi/show.pl?target=patchpage

Solaris 10 119689-06 (libc.so.1 Patch)
138352-02 ( X11 6.6.2: fontconfig patch )
117461-08 (ld patch)
118822-27 (kernel patch)
118707-04 (Expert3D IFB Graphics Patch)
118712-08 (Sun XVR-100 Graphics Accelerator Patch)
118711-02 (M64 Graphics Patch)
118708-11 (Sun XVR-1200 Graphics Accelerator Patch)

Red Hat Linux
Details

For installation information, see the Red Hat Linux Installation Guide at
http://www.redhat.com/docs/manuals/linux/ .
The following is the minimum RPM and RPM version recommendation based on RHEL 4
Update 1 and Redhat 5 — the required RPM version for your system may vary:

Linux RHEL 4.x 32-
bit

kernel-2.6.9-11.EL   
glibc-2.3.4-2.9    
elfutils-0.91.3    
elfutils-libelf-0.91.3     
openmotif-2.2.x...i386   
libpng-1.2.X .i386
redhat-lsb-3.0

Linux RHEL 4.x
(x86_64)

kernel-2.6.9-11.EL
   glibc-2.3.4-2.9
   elfutils-0.91.3
   elfutils-libelf-0.91.3
   openmotif-2.2.x...x86_64
   openmotif-2.2.x...i386
   libpng-1.2.X...x86_64
   libpng-1.2.X .i386
   redhat-lsb-3.0

Linux Redhat 5.x
32-bit

kernel-2.6.18.X  
 glibc-2.5-49    
 elfutils-0.137-3   
 elfutils-libelf-0.137-3  
 openmotif22-2.2.3-18...i386   
 libpng-libpng-1.2.10...i386
 redhat-lsb-3.1-12

Linux Redhat 5.x
(x86_64)

kernel-2.6.18.X    
glibc-2.5-49      
elfutils-0.137-3     
elfutils-libelf-0.137-3    
openmotif22-2.2.3-18...x86_64
openmotif22-2.2.3-18...i386  
 libpng-libpng-1.2.10...x86_64
libpng-libpng-1.2.10...i386 
redhat-lsb-3.1-12

Novell Linux
Details

Agilent EEsof recommends the following patches for Novell Linux systems:

Linux SUSE SLES
10 (32Bit or
x86_64)

All base errata in SLES 10 SP3
including the rpm  lsb-3.1.X

Linux SUSE SLES 9
(32Bit or x86_64)

All base errata in SLES 9 SP4
plus the rpm  lsb-3.0.X

  

 Solaris Window Style Manager

On Solaris, the Window Style Manager may set transient dialogs (modeless dialogs) so
that they do not remain on top when another window is selected. For example, if you open

http://sunsolve.sun.com/pub-cgi/show.pl?target=patchpage
http://sunsolve.sun.com/pub-cgi/show.pl?target=patchpage
http://www.redhat.com/docs/manuals/linux/
http://www.redhat.com/docs/manuals/linux/
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a Measure window, then select a Layout window, the Measure window may be covered by
the Layout window. To change this behavior, perform the following steps:

Open desktop Controls.1.
Open Window Style Manager.2.
Remove selection from the Allow Primary Windows on Top option.3.
Restart Window Style Manager.4.
Start ADS.5.

 User Complied Models

For dynamic User Compiled Models (UCMs), recompilation is required only for platforms
where the compiler has been upgraded. For example, if you are doing 32-bit models,
going from ADS 2009 Update 1 to ADS2011.01, the compilers have been upgraded for
Sun and Linux so recompilation is required.

For static UCMs, recompilation is required for every upgrade.

The following table shows the required compilers for the current release and back to ADS
2006A:

ADS Release Solaris HP-UX RH Linux Windows

2011 C++: CC:
SunStudio 12

HP-UX is no longer supported C++:
gcc Version
4.4.2

Visual Studio
2008

2009 C++: CC:
SunStudio 12

HP-UX is no longer supported C++:
gcc Version
4.1.1

 

2008 C++: CC:
SunStudio 12

HP-UX is no longer supported C++:
gcc Version
4.1.1

 

2006A and 2006
Update

C++ and CC:
Sun C+\ (Sun
Studio 10)

C++:
aCC HP ANSI C++ B3910B A.03.63
C:
cc or B3899BA B.11.11.12 HP C/ANSI C
Developer's Bundle

C++:
gcc Version
3.3.2

 

  

 Checking the Operating System Version

To determine the version that you are currently running, at the system prompt type:

uname -r (All UNIX and Linux platforms)

 
 

 Obtain Licenses
Though you can install all ADS features, but you can use only those features that have
valid licenses. To obtain a license, you can submit an online request at License Request
Form. The licenses are then emailed to you in a license file, file with extension .lic, for
example license.lic. You can also tie your licenses to a hardware key or dongle. To
obtain a valid hardware key, contact Agilent EEsof Business Support.

For information on how to setup your ADS license using ADS License Setup Wizard, see
License Setup through Wizard, otherwise see ADS License Setup - Unix and Linux (install).
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 Linux Systems

If you are using your LAN card's Ethernet ID to run the FLEXnet licensing system on your
PC and you have more than one network card (such as a permanent LAN card and a
removable WLAN card) inform your Agilent sales representative to assist you in selecting
the correct ID when you request licenses. Use the following command to read the ID, and
copy the address returned for Ethernet HWAddr. This Ethernet HWAddr ID must be
mentioned while you submitting your License Request Form.

/sbin/ifconfig

 

 Back Up Data from Previous Installations
You are advised to backup your important data and designs before uninstalling any ADS
version.

 
  

 Check Available Memory  
You need a minimum of 512 MB of memory installed on your system. More memory
results in better overall system performance for some design work.

To check the memory available in you system, enter the following command at a
command prompt:

/bin/dmesg

Check for the Memory line which includes the amount of available memory.

 

  

 Check Available Disk Space

The amount of disk space required depends on the ADS features that you want to install.
Approximately 4.5 GB of disk space is required to install all ADS features. To check the
available disk space, enter the following command at command prompt for the
workstation you are using:

Workstation Command

Red Hat
Linux

df -k

Solaris df -k

Note
ADS requires at least 20-30 MB of free disk space under /tmp and var/tmp to work properly.

 

 Checking Swap Space
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The minimum swap space required is 300 MB. Very large designs, and designs with many
hierarchical levels, may require more swap space.

To check the swap space available on your system, enter one of the following:

Workstation Command

Red Hat
Linux

/usr/bin/free -t

Solaris /usr/sbin/swap -s

  

 Defining an Install Location
Ensure that you must have permissions to write to the disk drive where you want to install
ADS. Also, while defining the install location for ADS:

You do not need to install as root, although you may need root privileges in some
cases.
If installed as root, all ADS files should have at least read permission for all users.

You can re-run the installation program to install ADS features you chose not to install the
first time.

For details on install steps and options, refer to Installing Advanced Design System on
UNIX and Linux (install).

Note
The installation program does not support cross-platform installations. Use the correct platform-specific
installation file for your system.

 Dataset Types
For existing ADS users, due to a change that removes the former limitation on dataset file
sizes, datasets created by ADS 2008 software (and subsequent releases) are not readable
by earlier versions of the ADS software. However, two new command-line programs are
available that can identify (and if necessary to change) the type of a given dataset.

 dstype

The dstype program identifies the type of one or more specified datasets.

Usage:

dstype

This program displays the type of the specified dataset filename(s). The filenames must
include the .ds dataset file extension. UNIX wildcards may be used in dataset filenames.
More than one filename can be specified on the command-line. Example:

$ dstype test.ds hbtest.ds junkfile.ds

test.ds: Agilent EEsof dataset, Release 2008 format

hbtest.ds: Agilent EEsof dataset, Release 2006A format

junkfile.ds: unknown file type (not a valid dataset)

The types are referred to as Release 2006A format and Release 2008 format. Release
2006A format applies to a dataset produced by any version of ADS before 2008. The
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Release 2008 format applies to a dataset produced by ADS 2008 or later versions.

 dsconvert

The dsconvert program performs type-conversion between the two dataset types.

Usage:

dsconvert [-f] [-d <2008_alloc_chunks>] 

Where <from_dataset> and <to_dataset> are the source and destination dataset
filenames, respectively, including the .ds extension. Only one file can be converted at a
time; do not use wildcards with the dsconvert program.

To prevent accidental overwriting, the destination dataset must not exist, unless the -f
option is given. The -f option forces the overwrite/deletion of an existing destination
dataset.

Conversion can be in either direction:

If <from_dataset> is in Release 2008 format, the program converts it to the Release
2006A format.
If <from_dataset> is in Release 2006A format, the program converts it to the Release
2008 format. (However, it is not actually necessary to perform this type of
conversion, as ADS 2008 is capable of reading datasets created by earlier versions.)

 

 Supported Features on 64-bit Operating Systems
The following simulators are supported when ADS is installed on a 64-bit Solaris or Linux
operating system:

64-bit Analog/RF
64-bit Momentum
64-bit Ptolemy

If you want to run these simulators in 32-bit mode or you want to use features that are
not available on a 64-bit operating system, you can launch ADS in 32-bit mode. See Using
32-bit Simulators on a 64-bit Operating System (install).

The following tables provide details about the supported features when ADS is installed on
a 64-bit operating system:
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Functionality Solaris64 Linux
RedHat64

Large Schematics, Netlists, Layouts 32-bit
mode

32-bit mode

Data Display / Large Datasets native 64-
bit

native 64-bit

3rd Party: DRC, Translators 32-bit
mode

32-bit mode

Utilities (LineCalc, Smith, DesignGuides) 32-bit
mode

32-bit mode

Connection Manager Client 32-bit
mode

32-bit mode

Connection Manager Server n/a n/a

Legacy Instrument Server n/a n/a

Dynamic Link to Cadence 32-bit
mode

32-bit mode

DSP Filter Tool 32-bit
mode

32-bit mode

Data Display AEL Expressions based on ADS Ptolemy
(evm_wlan_dsss_cck_pbcc(), evm_wlan_ofdm(), spectrum_analyzer())

32-bit
mode

32-bit mode

FlexLM License Server 32-bit
mode

32-bit mode

Circuit Simulation Solaris64 Linux
RedHat64

Circuit Simulation Engine, Local Simulation
(assume no external cosims or linked executables)

native 64-bit native 64-bit

Circuit Simulation Engine, Remote Simulation
(assume no external cosims or linked executables)

native 64-bit native 64-bit

Verilog-A all native 64-bit only, or all 32-bit in
compatibility mode, no 64/32-bit mixture

native 64-bit
only

User-Compiled Models, SimKit, MINT all native 64-bit only, or all 32-bit in
compatibility mode, no 64/32-bit mixture

native 64-bit
only

LSF n/a n/a

A/RF Modulated-Source-DSP-Based (assume no
3rd party cosims)

native 64-bit native 64-bit

A/RF Wireless Test Benches (assume no 3rd party
cosims)

native 64-bit native 64-bit

System Simulation Solaris64 Linux RedHat64

Ptolemy Engine (assume no user-compiled
models)

native 64-bit native 64-bit

Ptolemy Remote Simulation native 64-bit native 64-bit

Ptolemy LSF native 64-bit native 64-bit

Ptolemy, User-Compiled C all native 64-bit only, or all
32-bit in compatibility mode,
no 64/32-bit mixture

all native 64-bit only, or all
32-bit in compatibility mode,
no 64/32-bit mixture

Matlab64 Cosim 32-bit mode 32-bit mode

HDL Cosim (NCSim and ModelSim) native 64-bit native 64-bit

HDL Cosim (VerilogXL) 32-bit mode 32-bit mode

89601 VSA Cosim n/a n/a

Ptolemy, Connection Manager Client 32-bit mode n/a

Ptolemy, Connection Manager Instruments
components (except for CM_LA_167xx_Source
and VSA 89600 components)

32-bit mode 32-bit mode

Ptolemy, Legacy Instrument Links (non-
connection manager)

32-bit mode 32-bit mode
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Note: All Connection Manager Client and Instrument components require that the
Connection Manager Server be installed on a remote Windows 32-bit XP or 2000 machine.

Momentum Simulation Solaris64 Linux RedHat64

Momentum Engine, Local native 64-
bit

native 64-bit

Momentum Engine, Remote Simulation native 64-
bit

native 64-bit

Momentum Visualization (and 3D Layout Viewer) 32-bit mode 32-bit mode

 Verifying Java (JRE) Installation
Use this two-step test to ensure the Java Runtime Environment is enabled and configured
correctly in your browser to use the search functionality provided in the documentation.
As a first step, check your browser preferences (Edit > Preferences), to verify that the
options to enable Java and JavaScript are selected, as shown in the following image.

Even if this preference is set correctly, displaying a documentation page may display the
following message.

This confirms that the Java Runtime Environment is not configured correctly. To verify the
Java Runtime Environment is configured correctly, go to http://www.java.com , click the
"Do I have Java?" link, and follow the online instructions. On Linux systems you may need
Admin privileges to configure plugins.

 

http://www.java.com
http://www.java.com
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 Installing Advanced Design System on
UNIX and Linux
Before starting the ADS installation on a unix or linux platform, see Before You Begin
UNIX and Linux Installation (install) for system requirements and other necessary details.

Note

The installation program does not support cross-platform installations.
If you installed an Early Access version of ADS, you should uninstall it before installing this release.

To install ADS on UNIX or Linux systems:

Log onto the system using an account that has permissions to write to the disk to1.
which you want to install.
Download ADS install file, ads2011_01_rXXX_linux_x86.tar, from the Agilent EEsof2.
EDA Web
and untar the using the command below:
tar xf ads2011_01_rXXX_linux_x86.tar

Change directory to the path of the extracted tar files, for example temp.3.
cd /temp

Start the installation program using the following command:4.
./SETUP.SH

At the Introduction window, click Next to read the License Agreement. This is a5.
usage agreement and is not related to the licenses required to run the software.
At the License Agreement window, after reviewing the agreement, choose:6.

I accept the terms of the License Agreement, then click Next to continue with
the setup.
I do NOT accept the terms of the License Agreement to end the setup program.

At the Choose Install Set window, choose7.
Complete to install the basic ADS software, design guides, examples, and
documentation. If you choose Complete, you can skip the next step.
Custom to choose which ADS features you want to install. For a list of Custom
Installation features, refer to Installation Features.

Note
You can install all features supported by ADS but you can run only those features of ADS for
which you have a valid license.

For a Custom installation, the next window lets you choose the features you want to8.
install. Click an feature name to see a description. Select the features you wish to
install and click Next to continue.

Note
You must choose to install the ADS programs and tools option since it is the basic ADS software.
You can always re-run the installation program to install other features.

At the Choose Install Folder window, enter the full path to the directory where you9.
would like ADS software to be installed. If you specify a directory that does not
already exist, the installation program will create it for you. The default directory is
/usr/local/ADS2011.01. Choose:

Next to install to the default destination or
Enter the full path or click Choose to browse to a different destination directory
then click Next to install to the specified folder.

At the Pre-Installation Summary, the installation directory you have selected is10.
shown, along with the available disk space on the disk partition that contains this
directory. If you want to keep the installation directory shown, click Install. If you
want to change the installation directory, click Previous.

http://www.agilent.com/find/eesof-ads-latest-downloads
http://www.agilent.com/find/eesof-ads-latest-downloads
http://www.agilent.com/find/eesof-ads-latest-downloads
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The Installing Advanced Design System 2011.01 window appears. When installation11.
is finished, the Install Complete window appears. Note the Host ID (aka MAC Address
or License ID) then click Done to close the installation program.
Configure user accounts. See Configuring User Accounts.12.
Use the FLEXnet security licenses from Agilent EEsof to create a license.lic file with13.
the correct SERVER and VENDOR line configurations. See Setting Up Licenses
(install).
Place the license.lic file in the licenses sub-directory of your ADS installation directory14.
and start FLEXnet to enable your licenses. See Setting Up Licenses (install).
Launch ADS. See Running Advanced Design System (install).15.
If you will be using license bundles, select a bundle using the Agilent License
Preference tool prior to running ADS. See Using the Agilent License Preference Tool
(install).

   

 Installation Features  

A complete ADS installation installs the following features (including FLEXnet files) and
requires approximately 4.5 GB of disk space. For a custom installation, you can choose
which features you want to install.

Feature Description Size

ADS programs and tools This is the basic ADS software, minus the following features 1.8
GB

DesignGuides and Application
Guides

Special interactive tool kits and handbooks for various design types 630
MB

Manuals & Help All documentation. If this option is not selected, ADS documentation
will not be available

700
MB

Examples All examples for Advanced Design System 1.3
GB

  

 Configuring User Accounts
Configure the user accounts that will run ADS as follows:

C Shell

Add the following at the end of $HOME/.cshrc:

setenv HPEESOF_DIR <install_directory>

setenv ADS_LICENSE_FILE <path_to_license_file>
Default: $HPEESOF_DIR/licenses/license.lic

set path = ( . $HPEESOF_DIR/bin $path )

Bourne or Korn Shell

Add the following at the end of $HOME/.profile:

HPEESOF_DIR=<install_directory>

ADS_LICENSE_FILE=_<path_to_license_file>
Default: $HPEESOF_DIR/licenses/license.lic
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PATH=.:$HPEESOF_DIR/bin:$PATH

export HPEESOF_DIR ADS_LICENSE_FILE PATH

Note
If you are running Common Desktop Environment (CDE) or HP VUE, your user account may be using
$HOME/.dtprofile or $HOME/.vueprofile respectively to set up your user account instead of .cshrc or
.profile. The .dtprofile and .vueprofile files contain a line that can be uncommented to activate the use of
.cshrc or .profile. Check with your system administrator or CDE or VUE documentation for details.

Once the user accounts are configured, each user should log in and verify that the new
environment variables are set. Type the env command and check that HPEESOF_DIR and
ADS_LICENSE_FILE are set and that PATH contains a path to the ADS bin subdirectory.

  

 Setting the Display

If you plan to run ADS from a remote computer and you want the display to appear on
your local machine, you will need to set the DISPLAY environment variable:

setenv DISPLAY <my_hostname>: 0.0 (C-Shell)

DISPLAY = <my_hostname>: 0.0 _(Korn Shell, Bourne Shell)
export DISPLAY

For a Sun Ray file server and diskless terminals using Solaris 8, you will need to set the
DISPLAY environment variable:

setenv DISPLAY <servername>$Display (C-Shell)

set DISPLAY = <servername>$Display (Korn Shell, Bourne Shell)

export DISPLAY

For details on using the Sun Ray appliance, refer to the Sun website at:

http://wwws.sun.com/sunray/index.html

  

 Installing to Multiple Disk Partitions or Directories
If you do not have a single partition large enough to hold the entire ADS installation, you
can spread the installation across partitions using symbolic or soft links. The symbolic
links are created before installation to redirect files to other partitions.

For example, suppose you want to install ADS with most of the software installed in
/opt/apps/eesof, but you want the example workspaces to be installed to /disk2 due to
lack of disk space in the /opt partition. Before starting the installation program you would
do the following:

Create the main installation directory:1.
cd /opt/apps

mkdir eesof

Create the directory that will hold the example files on / disk2:2.

http://wwws.sun.com/sunray/index.html
http://wwws.sun.com/sunray/index.html
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cd /disk2

mkdir ads_examples

Create a link named examples in the main installation directory that points to the3.
/disk2/ads_examples directory:
cd /opt/apps/eesof

ln -s /disk2/ads_examples examples

Begin the installation process. When the examples are installed, the example4.
workspaces will follow the /opt/apps/eesof/examples link to /disk2/ads_examples.

Following is a list of the larger directory (not the complete list) names for ADS, along with
approximate sizes. Any of these directories can be re-directed to another disk partition as
shown above for the examples directory. The sizes shown are for a complete installation.

Directory Name Approximate Size

doc 900 MB

examples 1.3 GB

DesignGuides 630 MB

 

 Using Multiple ADS Versions
Use the following instructions to maintain and run more than one version of ADS (such as
version 2009Update1 and 2011.01). Keep a separate $HOME directory for each version of
ADS to help in structuring all the files and prevent problems that may arise if the
configuration files are shared between multiple installations. The $HOME directory is
where all your workspaces are kept.

  

 Setting the HOME Environment Variable

You need to specify the variable $HOME separately for each version of ADS that you want
to run. You can set up two directories from which you can run different scripts to launch
the version of ADS you want.

Below are example scripts. You can customize them as per your requirements.

 

 Script for ADS 2011.01

#!/bin/ksh

# Script for starting ADS 2011.01 on UNIX and Linux systems.

cd /users/jdoe/ads2011.01

HOME=/users/jdoe/ads2011.01

HPEESOF_DIR=/utils/eesof/ads2011.01

PATH=$HPEESOF_DIR/bin:$PATH

export HOME HPEESOF_DIR PATH

ads

 

 Script for ADS 2009 Update 1

#!/bin/ksh

# Script for starting ADS 2009 Update 1 on UNIX and Linux systems.

cd /users/jdoe/ads2009u1
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HOME=/users/jdoe/ads2009u1

HPEESOF_DIR=/utils/eesof/ads2009u1

PATH=$HPEESOF_DIR/bin:$PATH

export HOME HPEESOF_DIR PATH

ads

  

 Installing Connection Manager
For details on Installaing Connection Manager, see Installing Connection Manager Server
for UNIX and Linux (install)
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 Before Setting Up Licenses - Unix or
Linux
 

 Obtaining Host Id/Hardware Key
Host Id (License ID) is the unique machine ID of the license server machine running
Solaris. On Linux, it is either the unique machine ID of the license server machine or the
LAN card's Ethernet ID. You can obtain the Host Id (Ethernet Address / License Id) by
using the below command (as per your operating system):

Operating System Command

Red Hat Linux & Suse /sbin/ifconfig -a eth0

Solaris /sbin/ifconfig –a

Notes

The 12-digit Host Id / Physical Address should be used without dashes, for example,1.
000805E1A8DF.
This example applies to LAN card users. Wireless Network Card users should locate their network2.
card in the text file and use that Physical Address.
To obtain Host Id of a Solaris machine, you must have the administrator permissions.3.

 

 Obtaining the ADS License File
You must have license file (file with extension .lic) before starting ADS license setup. If
you have not received the same, you can place your ADS license request for:

New Sale License Request
New Release License Request
Renew Expired License
Early Access License Request
Change / Transfer Licenses
Evaluation License / Token Redemption / Renewal Request
Temporary / Provisional License Request

 Evaluation License

If your request for ADS evaluation license is approved, you will receive a license file (of
ADS license version 2.9) as an attachment through e-mail. Save this license file on your
computer.

Click here  to order ADS evaluation / trial version.

 Purchased License

If you purchase the ADS license, you will receive an e-mail containing an entitlement
certificate. Follow the instructions in e-mail which directs you to the Agilent Software
Manager (ASM) to redeem the certificate for a license file. The license file will be sent
through e-mail. You can also downloaded the license file from the Agilent website. Save
the license file on your computer.

https://edasupportweb.soco.agilent.com/license/faces/licensehome.jsp
https://edasupportweb.soco.agilent.com/license/faces/licensehome.jsp
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 License Types
ADS supports the following license types on Unix / Linux machines:

Node Locked Counted: This license type is used for accessing ADS on current1.
machine.For example:

SERVER unknown 81AAAAAA
VENDOR agileesofd
INCREMENT ads_datadisplay agileesofd 2.7 08-nov-2007 1 \
VENDOR_STRING="81AAAAAA : DXNLFPQ WZBCLQ2 AUJXJ2E IEKCKLI \
WFYQNVM DNJU1YM LHYKAQC OM" HOSTID=81aaaaaa START=11-nov-2007 \
SIGN="0169 4457 1B00 5266 852D 7813 5FB6 F38F 941A 1D0F E300 \
F868 5245 2627 CF7B 03B9 037F 9F0F 6BAE 32F6 321C"
INCREMENT ads_layout agileesofd 2.7 08-nov-2007 1 \
VENDOR_STRING="81AAAAAA : KSGSOTJ D1JYAXW BOCLRMW 2YNB2HN \
GFVU2LG FQ1AQPJ UGW" HOSTID=81aaaaaa START=11-nov-2007 \
SIGN="0115 CEDE 58A8 A734 FF5C 8AC8 A3AC DAE6 FD7E E9D2 C002 \
EB4B 0FF8 884C 61BE 84D7 AB0F A3E2 47EA EC43 A5E6"

Floating: This license type is used to run license server to cater the licences to the
remote machines.For example:

SERVER unknown 77542052
VENDOR agileesofd
INCREMENT ads_datadisplay agileesofd 2.7 08-nov-2007 1 \
VENDOR_STRING="2002002002 : DXNLFPQ WZBCLQ2 AUJXJ2E IEKCKLI
WFYQNVM DNJU1YM LHYKAQC OM" START=11-may-2007 SIGN="03CC 8B82 \
5582 2A7F 7A5D B54F 05C8 ED12 3789 AFD6 DB00 D838 8120 E013 \
DF09 F741 CD95 4240 7B56 C012 822E"
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 ADS License Setup - Unix and Linux
 After installing ADS, you need to setup your ADS license before you can run ADS. This
section provides license setup information for ADS on a Unix/Linux based PC.

Note
The ADS License Setup Wizard starts automatically once ADS is installed successfully. If you have
already received your license file (file with extension .lic), then you can also proceed with the license
setup using License Setup wizard. For more details on setting up license through wizard, see License
Setup through Wizard.

 License Installation Overview
The following flowchart illustrates the steps that help you complete the ADS license setup
(without using ADS License Setup Wizard).

 

 Get Host Id
To obtain the host id of your machine see Obtain Host Id (instalpc).

 Installing the FLEXid Driver on Linux

Complete the following steps to install the latest FLEXid driver needed to license ADS. You
need to do this only if you wish to lock your licenses to a hardware key. Be aware that to
install dongle drivers on Linux, you must be be root or have "sudo" privileges. Acresso
recommends that you install the FLEXid System Driver with their installer.

To install the Acresso FLEXid Driver:

If you have the hardware key connected to the machine, unplug it.1.
Locate the downloaded ADS installation tar file and untarred installation image.2.
Use the package manager utility, rpm, to install the driver:3.
rpm -i aksusbd-redhat-1.8.1-3.i386.rpm

Connect the hardware key to the machine.4.
Confirm that the key is working properly. To do this, run a utility from the installation5.
directory. If you installed ADS in /hfs/d1/ads2011_01, then the command would be:

> cd /hfs/d1/ads2011_01/EEsof_License_Tools/  e.g.

/hfs/d1/ads2011_01/EEsof_License_Tools/linux_x86
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> lmutil lmhostid -flexid

lmutil - Copyright (c) 1989-2008 Acresso Software Inc. All Rights Reserved.

The FLEXnet host ID of this machine is "FLEXID=9-a8675309"

For additional information, see the FLEXnet_ID_Dongle_Drivers.pdf file located in the
UNIX/dongle_sup directory. This directory also contains the files needed to install a USB
hardware key. For the most up-to-date files, contact your hardware key vendor.

For information about linking your LAN card's Ethernet ID to your ADS licenses, see Before
You Begin UNIX and Linux Installation (install).

 Installing a Hardware Key on Linux

If you are using a hardware key for ADS license, run FLEXnet to install the FLEXid
hardware key (also called a dongle) on a parallel or USB port of your computer. In a node-
locked environment, hardware key is installed on the local machine. In a floating license
environment, it is only required on the server machine.

Notes

Before installing the hardware key, note the hardware key ID number. If you have not already1.
received your security licenses from Agilent EEsof, you will need to provide this number for your
License Request Form, as explained in the section, License Types (instalpc).
ADS 2011.01 installs version 11.9.0.0 of FLEXnet. Make sure you use the latest version of the2.
FLEXnet software, drivers, and hardware key as needed on all ADS systems and license servers.

 

 Obtain License File
You must have a valid license file to start the license setup. Click here  to order ADS
evaluation / trial version. Once your license request is approved, license file is mailed as
an attachment to registered email id.

You can also contact Agilent EEsof business support for license file.

 

 License Setup
The following section provide instructions to install ADS license. You should have installed
ADS before you complete these steps. For details on installing ADS on a PC running
Windows, refer to Installing Advanced Design System (instalpc).

Notes

Use the following information to update all existing license servers with the latest version of the1.
FLEXnet software (for example, lmgrd and lmutil). The software is installed with ADS 2011.01. Using
older versions may cause license-encryption errors, invalid hostid results, and unsupported feature
errors.
Verify that all multiple and redundant servers are updated including any license administration2.
scripts in use. Run lmutil from the $HPEESOF_DIR\EEsof_License_Tools for information to help
modify the scripts.
Restart the license server.3.

 

 Place License File

https://edasupportweb.soco.agilent.com/license/faces/licensehome.jsp
https://edasupportweb.soco.agilent.com/license/faces/licensehome.jsp
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 A copy of the license.lic file must be placed on all SERVER machine(s) listed in the
license.lic file.

 

 License Placement Guidelines

The recommended location for the license.lic file is:
$HPEESOF_DIR/EEsof_License_Tools/linux_x86_xx/licenses/license.lic
You might need root permission to copy the license.lic file into the ADS installation
directory if ADS was installed by a user logged in as root.
You can choose to locate the license.lic file someplace else on the SERVER
machine(s). If you choose to do this, make sure that ADS users properly set
ADS_LICENSE_FILE.
Make sure that the license.lic file has at least read permission for all users:
cd $HPEESOF_DIR/EEsof_License_Tools/linux_x86_xx/licenses

chmod 555 license.lic

This command gives you read/executable permissions only.
Place a copy of the
$HPEESOF_DIR/EEsof_License_Tools/linux_x86_xx/licenses/license directory on all
SERVER machines or custom install the FLEXnet license server on each machine.

 

 Edit the License File

 Edit your license.lic file to correct the SERVER line and add information to the VENDOR
line. Refer to SERVER Line Guidelines (install) and VENDOR Line Guidelines (install) for
details. You can use the Agilent License Information Tool to check your environment
variable settings, display your license.lic file, and show your license and server status. For
details, refer to Using the Agilent License Information Tool (install).

Note
Each line in the license.lic file must be a single continuous line with each field separated by a single space.
You may line wrap lines using the backslash ('\') character, but be very careful not to add a space after
the backslash. Otherwise, you can remove the backslash and make each INCREMENT line one continuous
line.
In the license file, # can be used to comment out the incremental codewords.

 

 

 SERVER Line Format

 The SERVER line, by default, has the following format:
SERVER hostname hostid [port]

Where:

hostname is the network name of the machine whose hostid appears in field 3 of the
SERVER line. Use one of the following commands to read the hostname for your
system:
Operating System Command

Red Hat Linux /bin/hostname

Solaris /bin/hostname

hostid (License ID) is the unique machine ID of the license server machine running
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Solaris. On Linux, it is either the unique machine ID of the license server machine or
the LAN card's Ethernet ID. Use one of the following commands to read the hostid for
your system:
Operating System Command

Red Hat Linux /sbin/ifconfig

Solaris /bin/hostid

To obtain the hostid when ADS is not installed on the system:

Operating System Command

Red Hat Linux /sbin/ifconfig -a eth0

Solaris netstat -p|grep
(hostname)

Note
The evaluation form accepts these addresses as one continuous 12-digit number, without the
colons.

port is an optional entry naming the TCP/IP port number that the license server will
listen at for license requests. An example port number is 27000.

  

 SERVER Line Guidelines

Your license file should contain an odd number of SERVER lines; for example, 1 or 3.
If you have 3 SERVER lines, the first SERVER is the primary license server and the
other two are backup servers. All three SERVER lines must use the same port
number.
You may only change the hostname and the optional port number fields.
Adding or removing SERVER lines requires a new license.lic file.
By default, Agilent EEsof sets hostname to unknown. The SERVER line does not
contain a port address. FLEXnet software assigns a port address in the range of
27000 to 27009. The examples in this documentation use a port address of 27000,
but your license file may differ. If you do not want to use the port address assigned
by FLEXnet, specify any other unused port number for your network.

Note
Enter a specific port address on the SERVER line for improved license check-out performance. You
may enter a port address outside the range of 27000 to 27009, as long as the address is not used
elsewhere. Also, set the environment variable ADS_LICENSE_FILE as described in Place License File.

If the hostid is wrong, or changes for some reason, you will need to request a new
license.lic file from Agilent EEsof.
Here are examples of properly configured SERVER lines:
SERVER joshua 2072EFE45 (default - FLEXnet assigns port address)
SERVER isaiah 20472A3D3 27000 (optional - port address is specified)

 

 VENDOR Line Format

 The VENDOR line, by default, has the following format:
VENDOR daemon_name [daemon_path] [options_file_path] [port]

Where:

daemon_name is the name of the vendor daemon.
daemon_path is an optional entry specifying a path to the vendor daemon.
options_file_path is an optional entry specifying a path to the FLEXnet options file.
port is an optional entry naming the daemon TCP/IP port number to use. A port
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number must be used when connecting to the daemon through a firewall.
 

 VENDOR Line Guidelines

During installation of ADS, the vendor daemon is installed in the
$HPEESOF_DIR/EEsof_License_Tools/<ARCH> directory, for example
/my_install_dir/EEsof_License_Tools/linux_x86

The daemon_name must be agileesofd.
The path to the options file is intentionally left blank. If you want to use FLEXnet
options, you must add a full path to your option file. To learn about FLEXnet options,
refer to Using FLEXnet Options (install). If the file does not exist and this option is
not blank, a warning message will appear in the flex.log file.

Here is an example of a properly configured VENDOR line including the daemon path,
options file path, and port number:

VENDOR agileesofd /my_install_dir/EEsof_License_Tools/linux_x86/agileesofd \

/my_install_dir/licenses/agileesofd.opt 27000

 For client systems connecting to a license server through an Internet firewall set up
on Windows PC, the port number the vendor daemon uses must be specified. If the
port is not specified, the default is chosen by the operating system at run time. If this
port number is specified, there may be a delay restarting the vendor daemon until all
clients have closed their connections to the vendor daemon.

Note
 Some clients may timeout before they can connect to a license server through a firewall set up on a
Windows PC. The default timeout period is 0.1 second. If you need a longer timeout period, you can
set the environment variable FLEXLM_TIMEOUT to a new value. Enter the value using microseconds.
Agilent EEsof recommends trying one second. For example:
FLEXLM_TIMEOUT=1000000Depending on your network, you may need to adjust the period so it is
long enough to allow connections without slowing down simulations excessively.

 

 INCREMENT Line Format

 The INCREMENT lines must have the following format:

INCREMENT feature vendord ver exp num vendorstring hostid sign

Where:

feature is the name of the feature licensed by this line.
vendord is the name of the vendor daemon that will manage this feature.
ver is the version of the feature licensed by this line.
exp is the expiration date of this license.
num is the number of licenses this line enables.
vendorstring is the CPU ID of the primary license server.
hostid is an optional field. If this field exists, it is the hostid of the machine that this
license is node-locked to. Only the machine whose hostid appears in this field may
checkout this license.
sign is the encrypted license.

  

 INCREMENT Line Guidelines
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None of the fields on the INCREMENT lines are editable. Any change made to any of
the fields on an INCREMENT line will make that feature invalid. The only valid edit of
an INCREMENT line is to add a backslash ('\') to line wrap the line. Be careful not to
add an extra space between fields when using a backslash to line wrap an
INCREMENT line.
'#' can be used to comment out the INCREMENT codewords.

Here are two examples of valid INCREMENT lines.
Floating license example:

INCREMENT ads_schematic agileesofd 2.7 06-nov-2007 1 \

               VENDOR_STRING="2003298463 : XMGBGCE PSUOKRT EIQGAUY DLBVVHE \

               IWNYES2 EWFTFGP AU2BKGR" START=09-may-2007 SIGN="0091 AE42 \

               01AF 69F0 7D18 E9D3 F651 4EF0 5EEA 6EB2 5D00 E0C2 F314 8CAE \

               AB9C 3262 A18A 0F3C 8178 EB11 F848"

Node-locked license example:

INCREMENT ads_schematic agileesofd 2.7 06-nov-2007 1 \

               VENDOR_STRING="2007560205 : XMGBGCE PSUOKRT EIQGAUY DLBVVHE \

               IWNYES2 EWFTFGP AU2BKGR" HOSTID=77a8f00d START=09-may-2007 \

               SIGN="01EB BB84 1441 154F 2E82 AFAA 3BDF 426A B6A9 3ACF 3A02 \

               AE86 3414 510C 08BD 9C1D C69D D3D7 9CD6 579D 68D9"

The backslash used to line wrap these two INCREMENT line examples is prefaced by a
space and contains a carriage return immediately after it. The '\' character is the
absolute last character of the line it is on.

 

 Start the License Server (lmgrd)

 Use the following procedure and guidelines to start the license server, lmgrd, on the
SERVER machine.

Important
Be sure to use the following guidelines to update all existing license servers with the latest version of the
FLEXnet software (e.g., lmgrd and lmutil). The software is installed with ADS 2011.01. Using older
versions may cause license-encryption errors, invalid hostid results, and unsupported feature errors.
Verify that all multiple and redundant servers are updated including any license administration scripts in
use. Run lmutil directly from the ADS 2011.01 installation location (
$HPEESOF_DIR/EEsof_License_Tools/<ARCH>) for information to help modify the scripts.
You will need to stop, then restart, the license server to make these updates.

 

 Guidelines for Starting lmgrd

You only need to run lmgrd on the SERVER machine(s).
If the SERVER machine(s) has ADS installed on it, you will find the FLEXnet license
manager daemon (lmgrd) in the $HPEESOF_DIR/EEsof_License_Tools directory. If
the SERVER machine does not have ADS installed, you can copy the
$HPEESOF_DIR/EEsof_License_Tools/linux_x86_xx/licenses directory from the
machine that has ADS installed.
ADS installs version 11.9 of FLEXnet. Make sure you use the version 11.6 lmgrd and
agileesofd supplied or a newer version of lmgrd. You can determine the version of
lmgrd and agileesofd by typing the following commands:
cd $HPEESOF_DIR/EEsof_License_Tools/<ARCH> , where ARCH can be linux_x86
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./lmgrd -v

./agileesofd -v

 

 To start lmgrd

 Change the directory to where lmgrd resides on the SERVER machine and execute lmgrd.
For example:

cd $HPEESOF_DIR/EEsof_License_Tools/<ARCH> , where ARCH can be

linux_x86

./lmgrd -c ../license.lic > ../flex.log

The login executing lmgrd must have full permissions to the licenses/bin directory and at
least write permissions to the directory specified for flex.log.

All error, warning and status messages will be redirected to the flex.log file. After starting
lmgrd, wait approximately 30 seconds, then look at the contents of flex.log to see if there
are any errors that need to be corrected.

 

 To verify that the licenses are available:

 Make sure that the flex.log file does not contain any errors, then run lmstat as follows:

cd $HPEESOF_DIR/EEsof_License_Tools

./lmutil lmstat -a -c ../license.lic | more

Or, you may launch the Agilent License Information Tool to do this. Refer to Using the
Agilent License Information Tool (install) for more information.

If the licenses are available, you should see a listing similar to the following:

lmutil - Copyright \(C\) 1989-2007 Acresso Software Inc. All Rights Reserved.

Flexible License Manager status on Mon 9/22/2007 12:42

License server status: 27000@joshua

   License files on joshua: ads2009U1/licenses/bin/../license.lic:

   joshua: license server UP \(MASTER\) v10.1

Vendor daemon status \(on joshua\):

 agileesofd: UP v10.1

Feature usage info:

Users of ads_schematic: \(Total of 3 licenses available\)

Users of ads_layout: \(Total of 3 licenses available\)

Users of trans_iges:  \(Total of 3 licenses available\)

Users of trans_dgsii:  \(Total of 3 licenses available\)

Users of trans_iff:  \(Total of 3 licenses available\)

Users of ads_lite:  \(Total of 3 licenses available\)

Users of ads_datadisplay:  \(Total of 3 licenses available\)

Users of sim_linear:  \(Total of 3 licenses available\)

Users of sim_harmonic:  \(Total of 3 licenses available\)

 

 Automating FLEXnet License Manager Startup

 
You can automate the FLEXnet startup so that lmgrd is started automatically each time
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the license server machine is rebooted by adding the following lines for a startup routine
to the appropriate rc file for your operating system:

\#\!/bin/sh

\#

\# Sample script for restarting EEsof License Server

\#

\### BEGIN INIT INFO

\# Provides: eesof license server

\# Required-Start: $network

\# Required-Stop:

\# Default-Start:  3 4 5

\# Default-Stop:

\# Description:  Start EEsof License Server

\### END INIT INFO

PATH=/bin:/usr/bin

export PATH

\\

su - licadmin  \-c "/ads/EEsof_License_Tools/linux_x86/lmgrd \-c  /ads/licenses/license.lic \-l

/ads/licenses/ads_server_log.txt"

echo "Starting Agilent EEsof FLEXnet license daemon......"

sleep 5

\\

You need to ensure that all references to /ads must be changed to the actual path of your
Agilent EEsof software installation directory.

Following are instructions for the supported operating systems:# Change to the appropriate directory:
/etc/rc.d/init.d (Linux)}}
/etc/rc3.d (Solaris)}}

Create a file in this directory named Sagileesofd.1.
The S is capitalized. All other letters are in lower-case.2.

Place the FLEXnet startup routine (shown above) into this file.1.
Set the permissions for this file as follows:2.
chmod 755 Sagileesofd

chown root Sagileesofd

chgrp sys Sagileesofd

For Linux license servers, run the command chkconfig --add  3.
/sbin/chkconfig --add Sagileesofd

For Solaris systems, create the following soft links:
ln -s /etc/rc.d/init.d/Sagileesofd rc3.d/S99Sagileesofd

ln -s /etc/rc.d/init.d/Sagileesofd rc4.d/S99Sagileesofd

ln -s /etc/rc.d/init.d/Sagileesofd rc5.d/S99Sagileesofd

 
 

 Set Environment Variables

 Provide Access to Licenses

 Before attempting to start ADS, you must configure each user's login environment to
allow access to the licenses on the SERVER machine(s). To do this you need to configure
the environment variable named ADS_LICENSE_FILE in the user's .profile or .cshrc.

For example:
C Shell:
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setenv ADS_LICENSE_FILE

$HPEESOF_DIR/EEsof_License_Tools/linux_x86_xx/licenses/license.lic

Bourne/Korn Shell:

ADS_LICENSE_FILE=$HPEESOF_DIR/EEsof_License_Tools/linux_x86_xx/licenses/license.lic

export ADS_LICENSE_FILE

You can avoid the need to have a copy of the license.lic file directly on the machine
running ADS by setting ADS_LICENSE_FILE as follows:

ADS_LICENSE_FILE=<port>@<SERVER_hostname>

where

port is the TCP port number from the SERVER line(s) of the license.lic file.

SERVER_hostname is the network name of a SERVER machine serving ADS
licenses. This must be a name that the SERVER is known by on the network. You
should be able to successfully ping this name from the machine that will run
ADS.

Or, if your license server is set up to search for an available port, your ADS_LICENSE_FILE
should read:

ADS_LICENSE_FILE=@<SERVER_hostname>

For example,

C Shell:

setenv ADS_LICENSE_FILE 27000@joshua

OR

setenv ADS_LICENSE_FILE@joshua

Bourne/Korn Shell:

ADS_LICENSE_FILE=27000@joshua

export ADS_LICENSE_FILE

OR

ADS_LICENSE_FILE=@joshua

export ADS_LICENSE_FILE

The syntax to access multiple license servers is as follows.

C Shell:

setenv ADS_LICENSE_FILE 27000@server1:27000@server2:27000@server3

Bourne/Korn Shell:
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export ADS_LICENSE_FILE=27000@server1:27000@server2:27000@server3

However, in this case, "server" should be replaced by the actual license server name or IP
address, and the "27000" may need to be changed to the actual port number on the
license server. Note that the list of servers is separated by colons ( : ). For details on
running FLEXnet-licensed products from multiple vendors refer to Merging Multiple Vendor
Licenses (install).

 

 Using a UNIX/Linux-to-PC Floating License

 A Windows PC system can access the UNIX or Linux license server's license.lic file in
either of two ways:

By copying the license.lic file from the UNIX/Linux license server to the Windows PC's
$HPEESOF_DIR/licenses folder
By setting the ADS_LICENSE_FILE variable on the Windows PC to point to the
UNIX/Linux license server as follows:

set ADS_LICENSE_FILE=<port>@<host>

For example:
set ADS_LICENSE_FILE=27000@joshua

where

27000 is the port number on the SERVER line in the license.lic file on the
UNIX/Linux license server

joshua is the hostname of the UNIX/Linux license server

Conversely, the license server can be a Windows PC with a floating license locked to a LAN
card or dongle hardware key and the UNIX/Linux computer can be set to point to it in the
same way by using its host name or IP address.

 Launch ADS
To run ADS, open a terminal window and enter the command:
ads

Note
Before starting ADS, the environment variables must be set properly.
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 Managing ADS Licenses - Unix or Linux
This section provides information on how to manage licenses of ADS and all the tools and
utilities of ADS.

 

 License Information Tool
 The Agilent License Information Tool is available to check your environment variable
settings, display your license file (license.lic), and show your license and server
status.You can access this tool in any of the following waysLinux:

Type {{$HPEESOF_DIR/EEsof_License_Tools/linux_x86_xx/aglmtool}}and press1.
Enter.
From the ADS main window, Choose Tools > License Information2.

For a current list of licenses available from Agilent EEsof with product descriptions and
part numbers, see License Codewords (instalpc).

  

 License Preference Tool
This tool is useful if you have purchased ADS License Bundles.

 License bundles typically start with a "b_" in their names. A bundle looks like any other
INCREMENT line in the license file, but ADS recognizes the feature name as a collection, or
bundle, of individual features. When ADS checks out the license bundle, it enables all the
functionality associated with the individual features.

By default, an ADS run-session has all the bundles available for checkout. However the
License Preference Tool can be used to limit the set of license bundles to be used by your
ADS session. It records such information in the environment variable
ADS_LICPREF_<hostname>. If you need more bundle selection flexibility to control which
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licenses are used on selected systems, see Manually Setting the License Bundle
Preference.

 

 Running the License Preference Tool

To start the License Preference Tool
Type {{$HPEESOF_DIR/EEsof_License_Tools/linux_x86_xx/aglmpref}}and press Enter

The License Preference tool allows you to view the available license bundles and their
features, and select bundles.

To see the features available in a bundle, click the expansion icon next to the bundle
name under Available License Bundles.
To select a bundle, choose one of the bundles listed under Available License
Bundles, then click Add button. The selected bundle appears under Selected
License Bundles.
To accept your choice, click OK. This sets the environment variable
ADS_LICPREF_<hostname> in
HKEY_CURRENT_USER\Software\Agilent\EEsof_License_Configuration registry.

Note
You must have write permissions to update the registry settings.

 How the License Preference Tool Works

When you run the License Preference tool, it attempts to locate a license file using
the following license definitions:

Environment variable ADS_LICENSE_FILE
HKEY_CURRENT_USER\Software\Agilent\EEsof_License_Configuration\ADS_LICENSE_FILE

in the registry
The License Preference Tool will show all possible bundles if a license file is not
located.
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You can select a bundle according to specific rules controlled by the License
Preference Tool.
ADS starts when a license bundle is selected, and ADS will not use a bundle unless it
is selected using the License Preference Tool.
If, while using ADS, the feature you attempt to use is not in the currently selected
bundle, ADS will attempt to check out a valid floating or nodelocked license for the
feature. This is known as license roll-over. If license roll-over fails to check out a
license, a license error will appear even if another bundle with the requested feature
is available.
You can then select another bundle that contains the feature. Save your work, and
exit ADS. Then run the License Preference Tool to remove and add bundles, and
restart ADS.

 

 Special Licensing Needs
Use the following information to accommodate any special licensing needs you may have.
 

 Using FLEXnet Options

 An options file enables the license administrator to control the security parameters of
FLEXnet. Specifically the license administrator can:

Allow the use of features based on user, hostname or display name.
Deny the user of features based on user, hostname or display name.
Reserve licenses based on user, hostname or display name.
Control the amount of information logged about license usage.

 

 Creating an Options File

 Use the desired options listed below to create the options file using any text editor.
Ideally, you should keep the options file in the same directory as your license.lic file. Also,
add the pathname to the options file in the license.lic file as the fourth field on the
VENDOR line for agileesofd as shown in the following example. (Remember to use the
backslash ('\') character if the file contains wrapped lines.)

VENDOR agileesofd //licenses/vendors/agileesofd \

//licenses/agileesofd.opt

You can include comments in your options file by starting each comment with a pound
sign "#". Everything in the options file is case-sensitive. Be sure that user names and
feature names, for example, are entered correctly. The available options are:

EXCLUDE
Deny a user access to a feature.
EXCLUDEALL
Deny a user access to all feature served by this vendor daemon.
GROUP
Define a group of users for use with any options.
INCLUDE
Allow a user to use a feature.
INCLUDEALL
Allow a user to use all features served by this vendor daemon.
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NOLOG
Turn off logging certain items.
REPORTLOG
Specify that a logfile be written suitable for use by the FLEXadmin End-User
Administration Tool.
RESERVE
Reserve licenses for an individual user or groups of users.
TIMEOUT
Works only for specified simulator and library licenses.
TIMEOUTALL
Works for all simulator and library licenses.

Use the following steps to create and use an options file:

Create an options file with your required options.1.
Modify your license.lic file so that the VENDOR or DAEMON line points to this option2.
file as shown in this example:

VENDOR agileesofd //licenses/vendors/agileesofd \

//licenses/agileesofd.opt

Start up your license server (lmgrd) that is pointing to your license file. You must3.
stop it first if it is running. It's important that a message is displayed or recorded in
the FLEXnet log verifying the license manager is using the options file. The following
example shows that the license manager is using the agileesofd.opt file containing
the TIMEOUTALL option set to 900 seconds:

17:35:14 \(agileesofd\) Using options file: "//licenses/agileesofd.opt"

17:35:15 \(agileesofd\) ALL FEATURES: INACTIVITY TIMEOUT set to 900 seconds

Set ADS_LICENSE_FILE to point to your license server.4.
Run ADS.5.

 

 Specifying the TIMEOUT Option

 You can set a custom time-out period for simulator and library licenses using the
TIMEOUT or TIMEOUTALL options. If you do not specify a time-out value in your options
file or do not have an options file, a default two-hour limit is used. These time-out options
apply to those application features that have explicitly implemented time-out via the
heartbeat function. This includes licenses for the Analog/RF and Signal Processor
simulators and for libraries, and do not affect licenses for the design environment and
data display. The time-out option sets the amount of time a feature may remain idle
before its license is released and reclaimed by the vendor daemon. The TIMEOUT option
enables you to identify specific licenses, and the TIMEOUTALL affects all licenses
(simulators and libraries).
To use TIMEOUT, add an entry for each feature to the options file using the following
format:

TIMEOUT feature_name seconds

where:

feature_name is name of the feature.

seconds is the number of seconds before inactive license is reclaimed. The
minimum value is 900 seconds (15 minutes). If you specify a time-out value
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smaller than the minimum, the minimum is used.

The option TIMEOUTALL works just like TIMEOUT, but applies to all features.

TIMEOUTALL seconds

Here are example entries you can include in your options file:

To set a time-out for the harmonic balance simulator to one hour (3600
seconds):

TIMEOUT sim_harmonic 3600

To set time-outs for multiple simulators to different periods:

TIMEOUT sim_linear 900

TIMEOUT sim_harmonic 3600

TIMEOUT sim_convolution 3600

To set a time-out for all simulators and libraries to one hour (3600 seconds):

TIMEOUTALL 3600

  

 Updating the License File

If you have been running FLEXnet and receive updated licenses from Agilent EEsof, you
can add the new licenses to the FLEXnet environment as follows:

Replace the existing license.lic files on the license servers and clients with the new1.
license.lic file.
On the primary server, run lmutil lmreread. This causes the lmgrd on the primary2.
server to re-read the license.lic file and update all of the other lmgrd processes on
the network.
After you have done this, you can run lmutil lmstat -a to verify that the license3.
servers have received the new license information.
If this does not work, you may need to stop all of the lmgrd processes on your
network and then restart the same. For detail, see Start the License Server (install)

 

 Merging Multiple Vendor Licenses

 When you are running FLEXnet-licensed products from multiple vendors, you have three
ways to prevent licensing conflicts during installation:

Multiple license server nodes; each running one lmgrd and one license file
One license server node running one lmgrd and one license file
One license server node running multiple lmgrds and multiple license files

Each lmgrd can only read a single license file. With the first option you will have more
license servers to monitor. With the third option you have only one server but multiple
lmgrds to administer.
Your product's license file(s) define the license server(s) by hostname and hostid in the
SERVER line(s) in the license file.
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If the license files for two or more products contain identical hostids on the SERVER
line(s), then these files can be combined.
If the license files for two products contain different hostids on a SERVER line, then
the license servers for those products will be running on different nodes and the
license files cannot be combined.

If you have two or more products whose license servers run on the same node (as
specified by the SERVER lines in the license files), you may be able to combine the license
files into a single license file.

If the SERVER lines in those files have identical hostids, then you can combine the
files into a single file.
If the SERVER lines have different hostids, then you must keep the license files
separate.

More precisely, you can combine two license files under the following conditions:

The number of SERVER lines in each file is the same.1.
The hostid field of each SERVER line in one file exactly matches the hostid field of2.
each SERVER line in the other file.

Some possible reasons license files may not be compatible are:

License files are set up to run on different server nodes, so hostids are different.
One file is set up for single server (has only one SERVER line), the other is set up for
redundant servers (has multiple SERVER lines).
One vendor uses a custom hostid algorithm, so the hostids on the SERVER lines are
different even though the files are for the same machine.

If your license files are compatible as described above, then you can combine license files
and run a single lmgrd, as described in Combining License Files from Multiple Vendors. If
the license files are not compatible, then you must keep the license files separate and run
separate copies of lmgrd for each license file, as described in Using Separate License Files
on the Same Server Node.

Important
There is virtually no performance or system-load penalty for running separate lmgrd processes.

 

 Combining License Files from Multiple Vendors

If your license files are compatible, you can combine them using any text editor. To
combine license files, merge all of the compatible license files into one file, then edit out
the extra SERVER lines so that only one set of SERVER lines remains. Write out this data,
and you have your combined license file.

If you combine license files from multiple vendors, it is a good idea to keep a copy of the
combined license file in each vendor's default license file location. This way, your users
can avoid having to set ADS_LICENSE_FILE, because each package finds its license
information in the default place. On UNIX and Linux, you can do this with a symbolic link
from each default location to the location of the combined license file.

 

 FLEXnet Version Component Compatibility
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When you combine license files for two different FLEXnet-licensed products, the products
may not use the same version of FLEXnet. FLEXnet is designed to handle this situation.
There are two basic compatibility rules for FLEXnet:

A newer lmgrd can be used with an older vendor daemon, but a newer vendor1.
daemon might not work properly with an older lmgrd.
A newer vendor daemon (or lmgrd) can be used with an older client program, but a2.
newer client program might not work properly with an older vendor daemon.

From these two compatibility rules come the simple rules for selecting which version of
administration tools to use:

Always use the newest version of lmgrd and the newest version of each vendor1.
daemon.
Use the newest FLEXnet utilities.2.

For specific application programs, you can use either the new or the old version (with the
assumption that the vendor daemon for that application is at least as new as the
application).

 

 Using Separate License Files on the Same Server Node

You must run a separate copy of lmgrd for each license file. When you run multiple copies
of lmgrd, there are two details to remember:

The port number on the SERVER line of each license file must be unique. You can use1.
a standard text editor to change the port number in each license file so that they are
all different.
You must make sure that you are using a compatible version of lmgrd when you start2.
it up for a particular license file. This can be done by using an explicit path to lmgrd.

When running client programs (such as a licensed application), you can set the
ADS_LICENSE_FILE environment variable to point to multiple license files. For example,
you may have a license file from vendor ABC and a license file from vendor XYZ with
incompatible servers. You can place the license file from vendor ABC into:

/user/flexnet/abc.lic

and the license file from vendor XYZ into:

/user/flexnet/xyz.lic

then set the ADS_LICENSE_FILE environment variable to point to both of them. The
syntax is as follows:

ADS_LICENSE_FILE=27000@server1;27000@server2;27000@server3

Note that each path is separated with a semi-colon.

ADS_LICENSE_FILE can point to only one license file for FLEXlm v1.x applications.

 

 Redundant License Servers
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 You can set up a redundant or backup license server(s), in case a primary server is
unavailable. If your license.lic file has the maximum number of SERVER lines (three), you
have a redundant license server configuration. The license setup is identical to a single
SERVER configuration, with the exception that no licenses will be available until a majority
of the license servers are running. That is, if you have three SERVER lines, at least two
must be up and running before any licenses will be available for checkout. Be sure that
the FLEXnet software is loaded and running on each server.

Note

If you have more than one SERVER line in the license.lic file, you must start lmgrd on all the
SERVER machines to enable the licenses.
You must explicitly set the port number, for example 27005, and complete the license setup again.

 

 Controlling License Path Settings

 The lmutil utility provides the lmpath function which allows direct control over FLEXnet
license path settings. You can use lmpath to add to, override, or get the current license
path set in the registry. This enables you to change or view path settings without locating
individual settings in the Windows registry on the PC or in the FLEXnet registry (.eesoflic)
on UNIX and Linux.

The lmutil utility is located in _$HPEESOF_DIR/EEsof_License_Tools/linux_x86_xx. This
location must be in your PATH, or use the following command before running the utility:

cd $HPEESOF_DIR/EEsof_License_Tools/linux_x86_xx

The usage for this function is:

lmutil lmpath -add | -override} {vendor_name | all} _license_path_list_

where

-add appends license_path_list to the front of the current license-path settings
or creates the list of license-path settings, if it doesn't exist, initializing it to
license_path_list. Duplicates are discarded.

-override overrides the existing list of license-path settings with the contents of

license_path_list. If license_path_list is the null string, "", the specified list is
deleted. For example:

lmutil lmpath -override agileesofd ""

Deletes the value of ADS_LICENSE_FILE from the registry.
lmutil lmpath -override vendor2 ""

Deletes the value of VENDOR2_LICENSE_FILE from the registry.
lmutil lmpath -override all ""

Deletes the value of LM_LICENSE_FILE from the registry.

vendor is a string naming a particular vendor daemon name. Affects the value of
vendor _LICENSE_FILE. For example, use agileesofd to affect
ADS_LICENSE_FILE.

all refers to all vendor daemons. Affects the value of only LM_LICENSE_FILE.
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license_path_list is the new path setting(s). On UNIX and Linux, this is a colon-
separated list, and on Windows it is a semi-colon-separated list. If
license_path_list is the null string, "", then the list is deleted for the specified
vendor. Though you can enter specific license file names, you gain flexibility by
entering only a path without a file name. This will include all *.lic files in the
same location.

Note

Environment variable settings (set in your shell) always override these registry settings.
lmutil lmpath –status (used in ADS 2009 Updated 1 and earlier versions) will not give valid results.

 

 

 Changing License Path Settings

When adding or overriding path settings, lmpath sets the FLEXnet entry in the Windows
registry on the PC, or changes the file $HOME/.eesoflic on UNIX and Linux. Here are
examples of how license settings may appear in each registry:
UNIX and Linux

ADS_LICENSE_FILE = /ads2003a/licenses:/ads2009U1/licenses

  

 Manually Setting the License Bundle Preference

If you are using license bundles, you are aware that you must select a bundle prior to
running ADS. Typically, bundles are selected by using the Agilent License Preference Tool.
This tool is discussed in Using the Agilent License Preference Tool. However, system
administrators and advanced users can manually configure environment variables when
they need more bundle selection flexibility. Proper configuration using these environment
variables control which licenses are used, and the systems using them.

The two environment variables that control bundle selection are:  

ADS_LICPREF<hostname> controls bundle selection specifically for the system
identified by <hostname>.
ADS_LICPREF controls bundle selection for all systems on a network with access to
the license server.

ADS looks for these variables in the following locations in the order given here:

Shell environment
<project_directory>/hpeesof.cfg
$HOME/hpeesof/config/hpeesof.cfg
$HPEESOF_DIR/custom/config/hpeesof.cfg
$HPEESOF_DIR/config/hpeesof.cfg

ADS first looks for ADS_LICPREF<hostname> in each of these locations. If ADS cannot
find a value for ADS_LICPREF<hostname>, then ADS looks for ADS_LICPREF. If
ADS_LICPREF is not found, no bundle is selected.
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 Examples

Joe Smith wants to use the pl_desenv bundle when he runs ADS on the system with
the hostname alpha. To set this up, Joe should add

ADS_LICPREF_ALPHA=pl_desenv

to the configuration file

$HOME/hpeesof/config/hpeesof.cfg
where $HOME is Joe's home directory

A system administrator wants to configure a system to use the pl_ui bundle when
anyone runs ADS on the system named beta, and to use the ltp_mmic bundle when
ADS is run on other systems. To set this up, the administrator should add

ADS_LICPREF_BETA=pl_ui and
ADS_LICPREF=ltp_mmic

to the configuration file

$HPEESOF_DIR/custom/config/hpeesof.cfg

  

 Accessing Licenses through a Firewall

There may be situations where it is necessary to check out FLEXnet licenses through a
firewall (or router). This may occur when a license server is behind a company firewall and
other sites or companies need to check out licenses.

Assuming your license agreement allows you to serve licenses in this manner, you can
enable license checkout through a firewall by configuring your firewall to allow TCP
communication through the TCP ports used by the license manager daemon (lmgrd) and
any vendor daemons you will run.

For example, assume you have a license server serving EEsof EDA licenses and your
license.lic file contains the following lines:

SERVER myserver 00809AC7123F8

VENDOR agileesofd /apps/flexnet/vendors/agileesofd

VENDOR agileesof /apps/flexnet/vendors/agileesof

DAEMON hpeesofd /apps/flexnet/vendors/hpeesofd

To set up your firewall to allow TCP access to the license server, you must specify a TCP
port number for lmgrd on the SERVER line and for each vendor daemon on the VENDOR or
DAEMON lines. For example:

SERVER myserver 00809AC7123F8 27005

VENDOR agileesofd /apps/flexnet/vendors/agileesofd port=1705

VENDOR agileesof /apps/flexnet/vendors/agileesof port=1706

DAEMON hpeesofd /apps/flexnet/vendors/hpeesofd port=1707

Note
After specifying TCP ports in your license.lic file, you must stop and restart your license server.

Next, configure your firewall or router to allow TCP communication through the TCP ports
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you specified in your license.lic file. In the example above this would be ports 27005,
1705, 1706, and 1707.

Finally, clients must set the ADS_LICENSE_FILE environment variable to the port number
assigned to the license server. Using the example above, the setting would be:

ADS_LICENSE_FILE=27005@myserver

Once this has been done, clients outside of the firewall will be able to access licenses from
your server.

Note
  Some clients may timeout before they can connect to a license server through a firewall set up on a
Windows PC. The default timeout period is 0.1 second. If you need a longer timeout period, you can set
the environment variable FLEXLM_TIMEOUT to a new value. Enter the value using microseconds. Agilent
EEsof recommends trying one second. For example:
FLEXLM_TIMEOUT=1000000
Depending on your network, you may need to adjust the period so it is long enough to allow connections
without slowing down simulations excessively.

 

 Managing Multiple ADS Versions
This section discusses how to manage the licenses for multiple versions of ADS.

 

 Backward Compatibility of Licenses

 The following table lists ADS versions with details of their license management:
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Release
Name

License
File
Version

Daemon
Name

FLEX
Version

License Environment
Variable

Default License File Location

ADS 1.5 1.5 hpeesofd FLEXlm
7.0g

LM_LICENSE_FILE $HPEESOF_DIR/licenses/license.dat

ADS
2001

1.7 hpeesofd FLEXlm
7.0g

HPEESOFD_LICENSE_FILE $HPEESOF_DIR/licenses/license.dat

ADS
2002

1.9 agileesof FLEXlm
7.2h
CRO

AGILEESOF_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2002C

2.1 agileesof FLEXlm
7.2h
CRO

AGILEESOF_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2003

2.3 agileesofd FLEXlm
8.2a
CRO

ADS_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2004

2.34 agileesofd FLEXlm
9.2a
CRO

ADS_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2005

2.35 agileesofd FLEXnet
10.1.3
CRO

ADS_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2006

2.6 agileesofd FLEXnet
10.8
CRO

ADS_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2008

2.7 agileesofd FLEXnet
11.4.1

ADS_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2009

2.8 agileesofd FLEXnet
11.6

ADS_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2009U1

2.8 agileesofd FLEXnet
11.6

ADS_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2011.01

2.9 agileesofd FLEXnet
11.9

ADS_LICENSE_FILE <install_folder>/EEsof_License_Tools/license.lic

The following table shows the license compatibility between various ADS releases. Note
that license compatibility also depends on the whether the license was available in that
release.

Licenses From
This Release

ADS
2011

ADS
2009

ADS
2008

ADS
2006

ADS
2005A

ADS
2004A

ADS
2003C

ADS
2003A

ADS
2002C

ADS
2002

Will Work With
This Release

         

ADS 20011 X X X       

ADS 2009U1 X X X       

ADS 2009 X X X       

ADS 2008  X X X      

ADS 2006   X X X     

ADS 2005A    X X X X   

ADS 2004A     X X X   

ADS 2003C      X X   

ADS 2003A      X X   

ADS 2002C        X X

ADS 2002        X X

 Combining ADS Licenses with Other Agilent EEsof EDA Licenses

 For ADS 2009, the vendor daemon agileesofd is used. This is the same vendor daemon
that was used for ADS 2003A, 2003C, 2004A, 2005A, 2006A, 2006 Update, and 2008. If
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you want to serve ADS 2009 licenses and earlier from the same server, you need to have
the latest version of lmgrd, v9.2a, and two or three DAEMON lines in your license file,
depending on how many versions you want to support. The ADS daemon names available
are:

agileesofd - for ADS 2003A, 2003C, 2004A, 2005A, 2006A, 2006 Update, 2008,
2009
agileesof - for ADS 2002 and 2002C
hpeesofd - up to and including ADS 2001

For example, the license file would include:

SERVER hpnmems 77a588a7 1700

VENDOR agileesofd /ads2009U1/licenses/vendors/agileesofd

VENDOR agileesof /ads2002C/licenses/vendors/agileesof

DAEMON hpeesofd /ads2001/licenses/vendors/hpeesofd

You would then add the INCREMENT lines for the different products to the file.

The name and extension of the license file are arbitrary (i.e., license.dat, license.lic or
adslicenses.txt). By default, all ADS versions up to and including ADS 2001 look for a file
named license.dat and all ADS versions from ADS 2002 to ADS 200A look for a file named
license.lic. You can use one of these names, or some other name you prefer. Whatever
name you choose to use, make sure you set the environment variables to point to your
license file.

The supported environment variables are:

ADS_LICENSE_FILE for ADS 2003A through 2009
AGILEESOF_LICENSE_FILE for ADS 2002 and 2002C
HPEESOFD_LICENSE_FILE for ADS 2001
LM_LICENSE_FILE for ADS 1.5 and earlier

For example, if the combined license file is named adslicenses.txt and you want to build a
license file that contains ADS 2009, ADS 2003C, ADS 2002C, ADS 2001, and IC-CAP 2001
licenses, then:

ADS 2003C and 2009 will use:
ADS_LICENSE_FILE=/licenses/adslicenses.txt
ADS 2002 and 2002C will use:
AGILEESOF_LICENSE_FILE=/licenses/adslicenses.txt
ADS 2001 will use:
HPEESOFD_LICENSE_FILE=/licenses/adslicenses.txt
IC-CAP 2001 will use:
LM_LICENSE_FILE=/licenses/adslicenses.txt

Each version of ADS uses a certain search order to look for the environment variable:

ADS 2003C through 2009 will first look for the environment variable named
ADS_LICENSE_FILE. If ADS_LICENSE_FILE and LM_LICENSE_FILE are both defined,
ADS 2003C through 2009 will use ADS_LICENSE_FILE and ignore LM_LICENSE_FILE.
If ADS_LICENSE_FILE is not defined, then ADS 2003C through 2009 will default to
LM_LICENSE_FILE.
ADS 2002 and 2002C will first look for the environment variable named
AGILEESOF_LICENSE_FILE. If AGILEESOF_LICENSE_FILE and LM_LICENSE_FILE are
both defined, ADS 2002 and 2002C will use AGILEESOF_LICENSE_FILE and ignore
LM_LICENSE_FILE. If AGILEESOF_LICENSE_FILE is not defined, then ADS 2002 and
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2002C will default to LM_LICENSE_FILE.
ADS 2001 will first look for the environment variable named
HPEESOFD_LICENSE_FILE. If HPEESOFD_LICENSE_FILE and LM_LICENSE_FILE are
both defined, ADS 2001 will use HPEESOFD_LICENSE_FILE and ignore
LM_LICENSE_FILE. If HPEESOFD_LICENSE_FILE is not defined, then ADS 2001 will
default to LM_LICENSE_FILE.
All previous ADS versions, up to and including ADS 1.5 will use LM_LICENSE_FILE.

Even though all versions of ADS will default to LM_LICENSE_FILE if that is the only
environment variable that exists, it is recommended that you use the supported
environment variables listed above.
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 Using Advanced Design System
To help you get started using ADS, this section includes some basic information along with
useful tips for resolving problems that might occur after you have installed ADS.

 

 Running Advanced Design System 
Environment variables must be set before you can run ADS. To set the environment
variables, see Configuring User Accounts (install).

Your FLEXnet license file must be properly configured and installed before you can run
ADS. To set up your license file, follow the instructions in License Setup (install).

To run ADS, open a terminal window and enter the command:

ads

Choose Help > Topics and Index > Quick Start for help on getting started with ADS.

 

 Starting ADS in Verbose Mode (Debug Mode)

 ADS 2006 Update can be started in verbose (debug) mode to display more information
about what is occurring as ADS runs. This extra information can be very useful to debug a
problem with ADS both at startup and in general operation. In verbose mode, ADS writes
log files that can be used by Agilent EEsof EDA Technical Support to help track down any
problems.

To start ADS in verbose mode, do the following:

Open a terminal window.1.
Type ads_verbose.2.

This will start ADS. You will see some messages indicating the location of two log files.
Note the location of these files as indicated in the messages. The file names are as
follows:

ads_daemon.log
ads_verbose.log

Note
If ads_verbose is not found, you may need to set the HPEESOF_DIR and PATH environment variables.

Run ADS until the problem you are trying to debug occurs, then take a look at the
ads_daemon.log and ads_verbose.log files for errors.

If you can't locate the trouble based on the contents of the log files, please contact Agilent
EEsof EDA Technical Support. You will want to e-mail the log files to the support engineer
working with you.
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 Using 32-bit Simulators on a 64-bit Operating System
On a 64-bit operating system, you can either use the default 64-bit simulators or you can
use the 32-bit simulators. To use the 32-bit simulators on a 64-bit system, do one of the
following:

Set the  EESOF_64BIT environment variable as follows:
EESOF_64BIT=0

or

Start ADS by opening a terminal window and entering the command:
ads -32bit

 Using a Remote Display
ADS has a Remote Display mode that improves graphics performance when using a
remote display on X11 systems.  A remote display is a display that's on a computer
different from the computer that is running ADS.

ADS automatically determines whether to turn on Remote Display mode.

Remote Display mode is automatically turned on for:

Exceed 10.0 and later
Exceed Freedom
Exceed On Demand 5.1 and later
A native linux X server running on a machine different from the machine running ADS
Any other X server that supports RENDER and is running on a machine different from
the machine running ADS

Remote Display mode is automatically turned off for:

Any X server that does not support the RENDER extension including:
Exceed 9.0 and earlier
Exceed On Demand 5.0 and earlier
VNC
A native Solaris X server (unless you have installed patches that provide the
RENDER extension)

Any X server running on the same machine as ADS

You can override this automatic behavior with the EESOF_REMOTE_DISPLAY environment
variable.  This environment variable has three settings:

AUTO provides the automatic behavior described above.
YES (or 1) turns on Remote Display mode unless the X server does not support the
RENDER extension.
Any other value turns off Remote Display mode.

For EESOF_REMOTE_DISPLAY to have an effect, it must be set before you launch ADS.  To
set this variable to YES using the Bourne shell (sh) or the Korn shell (ksh), use

EESOF_REMOTE_DISPLAY=YES

export EESOF_REMOTE_DISPLAY

For the C Shell (csh), use
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setenv EESOF_REMOTE_DISPLAY YES 

  If ADS Does Not Start
 It is possible to install programs or options for which you have not purchased licenses.
Although the icons and features will appear in the software, you cannot access the
applications without a license. Contact your Agilent EEsof sales representative to obtain
additional licenses.

If your ADS applications will not start:

Make sure all of your licensing requirements are correctly set up, as explained in
Managing ADS Licenses - Unix or Linux (install).
Using a text editor, open and review the install.log file in your installation directory to
see if there are any apparent problems with the installation structure. (You can re-
run Setup if necessary to re-install.)
Try using the Agilent License Information Tool, which is available to check your
environment variable settings, display your license.lic file, and show your license and
server status. Refer to Using the Agilent License Information Tool (install).

If you cannot find the problem, run ADS in verbose (debug) mode and contact Technical
Support to help pinpoint the problem. See Starting ADS in Verbose Mode (Debug Mode).

   

 Printing and Plotting
Printing and plotting from ADS on UNIX is accomplished by establishing the desired print
setup and then choosing File > Print. The Print Setup and related dialog boxes enable
you to:

Select a printer/plotter other than the default
Install additional printers or plotters
Set the print resolution (dpi)
Scale the output

When you select a printer/plotter, you can also change the following default
printer/plotter-specific options:

Page Size
Source (Paper Tray)
Duplexing (Double-sided)
Orientation (Portrait or Landscape)
Color (Black and White or Color)

When you choose File > Print, you can select from the following additional options:

Choose to send output to a printer/plotter or print to file
Scale the output to fit to the page
Select a file format (if printing to file)
Specify the number of copies

Your print setup is saved in $HOME/.Xprinterdefaults. If you do not have a local copy of
this file, or the file .Xpdefaults (from a previous release), the default file is read from the
$HPEESOF_DIR/xprinter directory. When you change your print setup, the changes are
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saved (as new defaults) to $HOME/.Xprinterdefaults.

Note
If you do have a file .Xpdefaults (from a previous release), the settings of this file are copied to the new
filename to serve as the starting point for your print setup. Both files are valid, depending on which
release of ADS you are using. The old file is maintained for running an earlier version of ADS, but the new
file is used when you run ADS 1.5 (or later).

   

 Setting Up a Printer

The Print Setup dialog box enables you to setup and manage your printer options. To
access the Print Setup dialog box,

Choose File > Print Setup. The Print Setup dialog box appears.1.

For detailed information on using the Print Setup dialog box, refer to the following
table. 

 Using the Print Setup Dialog box
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Option Description

Printer Use this section of the Print Setup dialog box to define and manage your printers.

  Name: Select a printer from the Name drop-down list. If the printer you want to use is not
available in the list, click the Printer Management button. For more information, refer
to Managing Printers.

  Printer Management If you want to add, replace, or remove a printer, click the Printer Management button
to access the Printer Management dialog box. For more information, refer to Managing
Printers

  Model Info: This section displays the selected printer model information.

  Resolution (dpi): This option enables you to set the print quality (resolution) in dots per inch (dpi).

  Scale Factor (%): This option enables you to set a scaling factor that defines the percentage of normal
size by which to enlarge or reduce the document on the page. Default is 100%.

Paper Use this section of the Print Setup dialog box to define the paper settings.

  Size: Use the Size drop-down menu to select the paper size. Default is Letter.
Note that paper sizes can vary depending on the paper manufacturer. If you own a
printer that provides a specific paper size that you are not familiar with, consult your
printer documentation for information on the paper size options available. The more
common American paper sizes are listed below in inches (Width vs. Height).
Letter = 8.50" (W) x 11.00" (H)
Executive = 7.25" (W) x 10.55" (H)
Legal = 8.50" (W) x 14.00" (H)
Tabloid = 17.00" (W) x 11.00" (H)
Ledger = 11.00" (W) x 17.00" (H)
Consult the International Organization for Standardization (ISO) for standard A through
D-sizes as well as RA and SRA-sizes.

  Source: Use the Source drop-down menu to select the tray that has the paper you want to use.
Default is the Upper tray.

  Duplexing: The Duplexing drop-down menu enables you to print on both sides of the paper. The
options available are:
-None - No duplexing, the document will only print on one side of the paper.
-Flip on Short Edge - This option prints on both sides of each sheet and flips the page
along the short edge of the paper.
- Flip on Long Edge - This option prints on both sides of each sheet of paper and flips
the page along the long edge of the paper.
The default Duplexing option is None.

Orientation Use this section of the Print Setup dialog box to define the orientation of your printed
page.

  Portrait Click this option if you want your output printed in portrait orientation mode. Portrait is
taller than it is wide when you view the text right-side up. Default is activated.

  Landscape Click this option if you want your output printed in landscape orientation mode.
Landscape is wider than it is tall when you view the text right-side up. Default is
deactivated.

Color Use this section of the Print Setup dialog box to define your color settings.

  Black and White Click this option if you want your output in black and white. Default is activated unless
the system detects support for color printer. If this is the case, the system will default
to the color option.

  Color Click this option if you want your output in color. Default is deactivated unless the
system detects support for color printer. If this is the case, the system will default to
the color option.

   

 Managing Printers

The Printer Management dialog box enables you to manage an individual printer or group
of printers. To access the Printer Management dialog box,

Choose File > Print Setup. The Print Setup dialog box appears.1.
Click the Printer Management button in the Print Setup dialog box. The Printer2.
Management dialog box appears.
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For detailed information on using the Printer Management dialog box, refer to the
following table. 

 Using the Printer Management Dialog Box

Options Description

Installed
Printers

The Installed Printers field displays a list of all currently installed printers.

Printer
Drivers

Use the Printer Drivers drop-down list to select a printer driver.

Defined
Ports

Use the Defined Ports drop-down menu to select a defined port.

Ports To define a new printer port and/or replace or remove an existing printer port, click the Ports
button to access the Ports dialog box. For more information on the Ports dialog box, refer to
Defining Printer Ports.

Add To install a new printer, select a printer driver and a defined port, then click the Add button. The
new printer appears in the Installed Printers list.

Replace To replace an existing printer, click the printer you want to replace in the Installed Printers list.
Then select a new printer driver and a new defined port. Click the Replace button to replace the
printer. The new printer appears in place of the old printer in the Installed Printers list.

Remove To remove an existing printer or group of printers, click the printer(s) you want to remove in the
Installed Printers list and then click the remove button.
A confirmation dialog box appears asking if you really want to remove the printer. Click OK to
confirm or Cancel to abort the removal process. If you click OK, the printer(s) no longer appears
in the Installed Printers list.

Help Click the Help button to access the online context sensitive help.

Close Click the Close button to dismiss the Printer Management dialog box and accept the changes.
Settings will be saved upon exit.

   

 Defining Printer Ports

The Ports dialog box enables you to define new printer ports and/or replace or remove



Advanced Design System 2011.01 - UNIX and Linux Installation

53

existing printer ports. To access the Ports dialog box,

Choose File > Print Setup. The Print Setup dialog box appears.1.
Click the Printer Management button. The Printer Management dialog box appears.2.
Click the Ports button. The Ports dialog box appears.3.

For detailed information on using the Ports dialog box, refer to the following table. 

 Using the Ports Dialog Box

Option Description

Ports The Ports field displays a list of ports. Port names can be any names you choose with the
exception of FILE: which is a reserved port name.

Edit Port The Edit Port field is used to enter a new port. After you have entered the port definition,
click the Add/Replace button.

Add/Replace Click the Add/Replace button to update the Ports list with contents of Edit Port field.

Remove If you want to remove a port from the Ports list, click the port name in the Ports list to
activate the Remove button. Click the Remove button to remove the selected port.

Import from
Spooler

Click the Import from Spooler button to generate a list of ports (based on your printcap file).

Note that this option is only guaranteed to operate on HP-UX platforms. It may operate on
other platforms; however, the third party utility that provides this feature does not
guarantee it.

Help Click the Help button to access the online context sensitive help.

Close Click the Close button to dismiss the Ports dialog box and accept the changes. Settings will
be saved upon exit.

   

 Printing to a Printer, Plotter, or File

The Print dialog box enables you to output your information to a supported printer,
plotter, or specified file. To access the Print dialog box,

Choose File > Print. The Print dialog box appears.1.
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Note
Alternatively, you can click the Print The Current Design button in the toolbar of a Schematic or
Layout window to access the Print dialog box. The Print this window button in the Data Display
uses the same user interface.

For detailed information on using the Print dialog box, refer to the following table. 

 Using the Print Dialog Box

Option Description

Printer The Printer options in the Print dialog box enable you to define a printer and the output
characteristics.

  Name: Select a printer from the Name drop-down list. If the printer you want to use is not
available in the list, click the Cancel button and access the Print Setup dialog box.

  Model Info: This section displays the printer model information.

  Status: This section displays information on the printer status. If the printer is ready to print, the
Status will display Ready.

  Properties Click the Properties button to view or set additional options used in the Print Setup dialog
box. For more information, refer to Setting Up a Printer.

  Fit to Page Activate the Fit to Page option if you want your output to be automatically scaled to fit on
the page.

  Print to File Activate the Fit to Page option if you want your output to be directed to a file.
When this option is selected, the Number of Copies feature is deactivated and the Print to
File feature is activated.
When this option is deactivated, the Number of Copies feature is activated and the Print
to File feature is deactivated.

Copies This section is used to set the number of copies to print.

  Number of Copies Use this feature to specify the number of copies to print. If Print to File is selected, this
feature is deactivated.

Print to File This section is used to define the type of file you want to send your output to.

  File Format: Use this feature to specify the file format to save your output to.
After you have selected your file format, click OK in the Print dialog box. A Print to File
dialog box will appear enabling you to define the path and name of the file. For more
information on the Print to File dialog box, refer to Printing to a File
If the Print to File radio button is deselected, this feature is deactivated.

OK Click the OK button to accept the settings and send your output to the selected printer or
file, depending on how you have set your options. Settings will be saved upon exit.

Cancel Click the Cancel button to dismiss the Print dialog box. Settings will not be saved upon
exit.

Help Click the Help button to access the online context sensitive help.
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 Printing to a File

The Print to File dialog box enables you to define a destination path and file name and
then output your information to the specified file. To use the Print to File dialog box,

Choose File > Print. The Print dialog box appears.1.

Select the Print to File option in the Printer section of the Print dialog box. Notice that2.
when you select the Print to File option, the Print to File section is activated enabling
you to select a file format.
Use the File Format drop-down list to select the desired file format. Options include3.
JPEG, GIF, PDF, Bitmap, and HP-GL/2.
Click OK in the Print dialog box. The Print to File dialog box appears.4.

Enter the file name for your output in the Selection field.5.
Click the OK button to output the file.6.

  

 Agilent EEsof Technical Support
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Agilent EEsof worldwide technical support is available Monday through Friday. The toll-free
North America hotline is open 6:00 am to 5:00 pm PT. Throughout Europe, the localized
Online Technical Support Centers are open during business hours, typically 8:30 am to
5:30 pm, local time; throughout Asia, the localized Customer Response Centers are open
during business hours, typically 9:00 am to 6:00 pm, local time.

The e-mail addresses for the various regions are listed below. However, for both the
regional e-mail addresses and local telephone numbers for more than 25 countries, please
refer to the Agilent EEsof Web site at

http://www.agilent.com/find/eesof-supportcontact

North America

Phone: 1 800 47 EEsof (473-3763) - Fax: 707-577-3511
e-mail: eesof_support@agilent.com

Europe: e-mail: eesof-europe_support@agilent.com
Japan: e-mail: eesof-japan_support@agilent.com
Korea: e-mail: eesof_korea@agilent.com
Asia: e-mail: eesof-asia_support@agilent.com

 
 Following are solutions to common problems that occur regarding the FLEXnet licensing
setup for ADS.
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

http://www.agilent.com/find/eesof-supportcontact
http://www.agilent.com/find/eesof-supportcontact
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 Troubleshooting and FAQs - Unix or
Linux
  If ADS Does Not Start
 It is possible to install programs or options for which you have not purchased licenses.
Although the icons and features will appear in the software, you cannot access the
applications without a license. Contact your Agilent EEsof sales representative to obtain
additional licenses.

If your ADS applications will not start:

Make sure all of your licensing requirements are correctly set up, as explained in ADS
License Setup - Unix and Linux (install).
Using a text editor, open and review the install.log file in your installation directory to
see if there are any apparent problems with the installation structure. (You can re-
run Setup if necessary to re-install.)
Try using the Agilent License Information Tool, which is available to check your
environment variable settings, display your license.lic file, and show your license
and server status. Refer to License Information Tool (install).

If you cannot find the problem, run ADS in verbose (debug) mode and contact Technical
Support to help pinpoint the problem. See Starting ADS in Verbose Mode (Debug Mode)
(install).

 

 Common Licensing Problems
 Following are solutions to common problems that occur regarding the FLEXnet licensing
setup for ADS.
 

 Where to Begin

If you are having trouble getting FLEXnet working, the best place to begin troubleshooting
is the flex.log file. The flex.log file is typically located in
$HPEESOF_DIR/EEsof_License_Tools/linux_x86_xx/licenses.

Read the flex.log file and look for error or warning messages.

If nothing shows up in the flex.log file, try setting the following environment variable, then
start ADS:

C Shell ( /bin/csh)

setenv HPEESOF_DEBUG_MODE key

Bourne/Korn Shell (/bin/sh, /bin/ksh)

HPEESOF_DEBUG_MODE=key

export HPEESOF_DEBUG_MODE

Look for errors or warnings in the shell where you started ADS.
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 Common Errors and Solutions

Following are possible solutions to certain license-related error messages that occur.

  ADS Does Not Run After Starting the License Server

 If you are unable to run ADS after starting the License Server, additional license
configuration may be needed as follows:
Run aglmwizard from <install_folder>/EEsof_License_Tools/linux_x86_xx folder

 

 Inconsistent Encryption Code

 This error occurs when the information on the INCREMENT lines in the license.lic file is
corrupted. Check the license.lic file for the following:

Make sure that each line of the license.lic file is a single continuous line with each1.
field separated by a single space.
If there are backslash characters ("\") line wrapping the lines, make sure that the2.
backslash character is the absolute last character on its line. Even a space after the
"\" will cause a problem.
Try removing the backslash characters and joining the INCREMENT lines, so that each3.
INCREMENT line is a single continuous line with no line wrap.
If the license.lic file was transferred from DOS to UNIX or Linux, make sure to4.
remove the control M's (^M) at the end of all the lines in the license.lic file. If spaces
are added to the end of each line to eliminate the ^M's, the spaces must also be
removed. The spaces turn out to be just as disruptive as the ^M's. The best way to
remove the ^M's is using the vi editor and the following substitution command:
:1,$ s/.$//g

Make sure that none of the original SERVER line HOSTID information has been5.
changed. Make sure that none of the SERVER lines have been eliminated.
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 Invalid Host or Unable to Determine Machine ID

This can be caused by one of the following: 

Make sure that the information on the SERVER line(s) in license.lic is correct.1.
If the licenses are node-locked, and you attempt to run ADS on a machine other than2.
the machine the licenses are node-locked to, you will get a license error indicating
invalid host. To check if this is the case, look at the
$HPEESOF_DIR/EEsof_License_Tools/linux_x86_xx/licenses/license.lic file and check
the INCREMENT lines. If each INCREMENT line ends in a machine hostid, then the
licenses are node-locked to the machine whose id is shown. You can, however, export
the display from the node-locked machine to another display.
If you are on an HP workstation, check the permissions of the /dev/lan0 file. This file3.
must have read and write permissions for all:
chmod 777 /dev/lan0

The FLEXnet lmgrd and agileeosf vendor daemons use this file and must be able to
read and write to this device.

 

 Invalid System Clock Time

 FLEXnet detects when systems have had their dates set more than 24 hours back, and
prevents users from using expired licenses by setting the clock back. It works by looking
for any files in "/" or "/etc" that have a date more than 24 hours in the future.
Use the command ls -lat in "/" and "/etc" to find the offending file(s). The date of the
offending file(s) can be corrected by using the touch command:

touch <filename>

If the file is a link, the link must be removed and then recreated. If the link itself is dated
ok, check the date of the actual file or directory it points to. The pointed to file must also
have a valid date.

 

 A Feature is Not Enabled

FLEXnet licenses have both enable and expiration dates. If the license enable date is in
the future with respect to the current machine date, then this error will occur. 

First check the date on the computer. If it is not today's date, correct it. The date can be
set using the date command:

Workstation Date Command

Red Hat
Linux

date MMDDhh[[cc]yy][.ss]

Solaris date mmddhhmm[[cc]yy]

For example, to set the date on a UNIX system to 23 Sept, 2004 at 13:30, the command
would be:

date 0923133004

If this still does not correct the problem, or if the date is correct, then request new
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licenses with an enable date set to today's date.

 

 Cannot Connect to License Server

 If you see a flex.log file with the following errors:

(lmgrd) Started agileesofd
(agileesofd) Vendor daemon can't talk to lmgrd (cannot connect to
license server) port 27000
(lmgrd) Vendor daemon died with status 241
(lmgrd) Since this is an unknown status, lmgrd will
(lmgrd) attempt to re-start the vendor daemon.
(lmgrd) REStarted agileesofd (internet tcp_port xxxx)

Make sure that the lmgrd and agileesofd daemon are the correct version (current version
is 11.6). The lmgrd daemon should have the same or higher version number as agileesofd
. You can check version numbers as follows:

cd $HPEESOF_DIR/EEsof_License_Tools/linux_x86_xx/licenses

./bin/lmgrd -v

./vendors/agileesofd -v

Make sure that the workstation is connected to a network or that the network connector
on the workstation is properly terminated. FLEXnet will not work if the network connection
is down or if the network services are not starting properly. Check all physical network
connections to make sure that they are okay and look for errors during machine boot up.
On HP  700 workstations, look at the /etc/rc.log file for errors.

Make sure that the agileesofd is being started successfully by lmgrd. If agileesofd cannot
be started from the path specified on the VENDOR line in the license.lic file, this error will
occur. Also make sure that the agileesofd file has execute permissions:

cd $HPEESOF_DIR/licenses/vendors

chmod 755 agileesofd

  

 Address Already in Use

The tcp port number specified on the SERVER line in the license.lic file is in use by another
process. Try the following: Kill any stranded lmgrd processes. Remove the
/ usr/tmp/.flexnet/lmgrd.xxxx file that contains the tcp port you want to use. You can
remove the entire /usr/tmp/.flexnet directory if you are the only one using lmgrd on this
machine, then restart lmgrd. If you still have a problem, try using a different tcp port
number on the SERVER line in license.lic and then restart lmgrd.

Here is an example of properly configured SERVER lines:

SERVER joshua 2072EFE45 27000

SERVER isaiah 20472A3D3 27000

SERVER jonah 2052C6416 27000

   

 Printing and Plotting
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Printing and plotting from ADS on UNIX is accomplished by establishing the desired print
setup and then choosing File > Print. The Print Setup and related dialog boxes enable
you to:

Select a printer/plotter other than the default
Install additional printers or plotters
Set the print resolution (dpi)
Scale the output

When you select a printer/plotter, you can also change the following default
printer/plotter-specific options:

Page Size
Source (Paper Tray)
Duplexing (Double-sided)
Orientation (Portrait or Landscape)
Color (Black and White or Color)

When you choose File > Print, you can select from the following additional options:

Choose to send output to a printer/plotter or print to file
Scale the output to fit to the page
Select a file format (if printing to file)
Specify the number of copies

Your print setup is saved in $HOME/.Xprinterdefaults. If you do not have a local copy of
this file, or the file .Xpdefaults (from a previous release), the default file is read from the
$HPEESOF_DIR/xprinter directory. When you change your print setup, the changes are
saved (as new defaults) to $HOME/.Xprinterdefaults.

Note
If you do have a file .Xpdefaults (from a previous release), the settings of this file are copied to the new
filename to serve as the starting point for your print setup. Both files are valid, depending on which
release of ADS you are using. The old file is maintained for running an earlier version of ADS, but the new
file is used when you run ADS 1.5 (or later).

   

 Setting Up a Printer

The Print Setup dialog box enables you to setup and manage your printer options. To
access the Print Setup dialog box,

Choose File > Print Setup. The Print Setup dialog box appears.1.
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For detailed information on using the Print Setup dialog box, refer to the following
table. 

 Using the Print Setup Dialog box
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Option Description

Printer Use this section of the Print Setup dialog box to define and manage your printers.

  Name: Select a printer from the Name drop-down list. If the printer you want to use is not
available in the list, click the Printer Management button. For more information, refer
to Managing Printers (install).

  Printer Management If you want to add, replace, or remove a printer, click the Printer Management button
to access the Printer Management dialog box. For more information, refer to Managing
Printers (install)

  Model Info: This section displays the selected printer model information.

  Resolution (dpi): This option enables you to set the print quality (resolution) in dots per inch (dpi).

  Scale Factor (%): This option enables you to set a scaling factor that defines the percentage of normal
size by which to enlarge or reduce the document on the page. Default is 100%.

Paper Use this section of the Print Setup dialog box to define the paper settings.

  Size: Use the Size drop-down menu to select the paper size. Default is Letter.
Note that paper sizes can vary depending on the paper manufacturer. If you own a
printer that provides a specific paper size that you are not familiar with, consult your
printer documentation for information on the paper size options available. The more
common American paper sizes are listed below in inches (Width vs. Height).
Letter = 8.50" (W) x 11.00" (H)
Executive = 7.25" (W) x 10.55" (H)
Legal = 8.50" (W) x 14.00" (H)
Tabloid = 17.00" (W) x 11.00" (H)
Ledger = 11.00" (W) x 17.00" (H)
Consult the International Organization for Standardization (ISO) for standard A through
D-sizes as well as RA and SRA-sizes.

  Source: Use the Source drop-down menu to select the tray that has the paper you want to use.
Default is the Upper tray.

  Duplexing: The Duplexing drop-down menu enables you to print on both sides of the paper. The
options available are:
-None - No duplexing, the document will only print on one side of the paper.
-Flip on Short Edge - This option prints on both sides of each sheet and flips the page
along the short edge of the paper.
- Flip on Long Edge - This option prints on both sides of each sheet of paper and flips
the page along the long edge of the paper.
The default Duplexing option is None.

Orientation Use this section of the Print Setup dialog box to define the orientation of your printed
page.

  Portrait Click this option if you want your output printed in portrait orientation mode. Portrait is
taller than it is wide when you view the text right-side up. Default is activated.

  Landscape Click this option if you want your output printed in landscape orientation mode.
Landscape is wider than it is tall when you view the text right-side up. Default is
deactivated.

Color Use this section of the Print Setup dialog box to define your color settings.

  Black and White Click this option if you want your output in black and white. Default is activated unless
the system detects support for color printer. If this is the case, the system will default
to the color option.

  Color Click this option if you want your output in color. Default is deactivated unless the
system detects support for color printer. If this is the case, the system will default to
the color option.

   

 Managing Printers

The Printer Management dialog box enables you to manage an individual printer or group
of printers. To access the Printer Management dialog box,

Choose File > Print Setup. The Print Setup dialog box appears.1.
Click the Printer Management button in the Print Setup dialog box. The Printer2.
Management dialog box appears.
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For detailed information on using the Printer Management dialog box, refer to the
following table. 

 Using the Printer Management Dialog Box

Options Description

Installed
Printers

The Installed Printers field displays a list of all currently installed printers.

Printer
Drivers

Use the Printer Drivers drop-down list to select a printer driver.

Defined
Ports

Use the Defined Ports drop-down menu to select a defined port.

Ports To define a new printer port and/or replace or remove an existing printer port, click the Ports
button to access the Ports dialog box. For more information on the Ports dialog box, refer to
Defining Printer Ports (install).

Add To install a new printer, select a printer driver and a defined port, then click the Add button. The
new printer appears in the Installed Printers list.

Replace To replace an existing printer, click the printer you want to replace in the Installed Printers list.
Then select a new printer driver and a new defined port. Click the Replace button to replace the
printer. The new printer appears in place of the old printer in the Installed Printers list.

Remove To remove an existing printer or group of printers, click the printer(s) you want to remove in the
Installed Printers list and then click the remove button.
A confirmation dialog box appears asking if you really want to remove the printer. Click OK to
confirm or Cancel to abort the removal process. If you click OK, the printer(s) no longer appears
in the Installed Printers list.

Help Click the Help button to access the online context sensitive help.

Close Click the Close button to dismiss the Printer Management dialog box and accept the changes.
Settings will be saved upon exit.

   

 Defining Printer Ports

The Ports dialog box enables you to define new printer ports and/or replace or remove
existing printer ports. To access the Ports dialog box,

Choose File > Print Setup. The Print Setup dialog box appears.1.
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Click the Printer Management button. The Printer Management dialog box appears.2.
Click the Ports button. The Ports dialog box appears.3.

For detailed information on using the Ports dialog box, refer to the following table. 

 Using the Ports Dialog Box

Option Description

Ports The Ports field displays a list of ports. Port names can be any names you choose with the
exception of FILE: which is a reserved port name.

Edit Port The Edit Port field is used to enter a new port. After you have entered the port definition,
click the Add/Replace button.

Add/Replace Click the Add/Replace button to update the Ports list with contents of Edit Port field.

Remove If you want to remove a port from the Ports list, click the port name in the Ports list to
activate the Remove button. Click the Remove button to remove the selected port.

Import from
Spooler

Click the Import from Spooler button to generate a list of ports (based on your printcap file).

Note that this option is only guaranteed to operate on HP-UX platforms. It may operate on
other platforms; however, the third party utility that provides this feature does not
guarantee it.

Help Click the Help button to access the online context sensitive help.

Close Click the Close button to dismiss the Ports dialog box and accept the changes. Settings will
be saved upon exit.

   

 Printing to a Printer, Plotter, or File

The Print dialog box enables you to output your information to a supported printer,
plotter, or specified file. To access the Print dialog box,

Choose File > Print. The Print dialog box appears.1.
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Note
Alternatively, you can click the Print The Current Design button in the toolbar of a Schematic or
Layout window to access the Print dialog box. The Print this window button in the Data Display
uses the same user interface.

For detailed information on using the Print dialog box, refer to the following table. 

 Using the Print Dialog Box

Option Description

Printer The Printer options in the Print dialog box enable you to define a printer and the output
characteristics.

  Name: Select a printer from the Name drop-down list. If the printer you want to use is not
available in the list, click the Cancel button and access the Print Setup dialog box.

  Model Info: This section displays the printer model information.

  Status: This section displays information on the printer status. If the printer is ready to print, the
Status will display Ready.

  Properties Click the Properties button to view or set additional options used in the Print Setup dialog
box. For more information, refer to Setting Up a Printer (install).

  Fit to Page Activate the Fit to Page option if you want your output to be automatically scaled to fit on
the page.

  Print to File Activate the Fit to Page option if you want your output to be directed to a file.
When this option is selected, the Number of Copies feature is deactivated and the Print to
File feature is activated.
When this option is deactivated, the Number of Copies feature is activated and the Print
to File feature is deactivated.

Copies This section is used to set the number of copies to print.

  Number of Copies Use this feature to specify the number of copies to print. If Print to File is selected, this
feature is deactivated.

Print to File This section is used to define the type of file you want to send your output to.

  File Format: Use this feature to specify the file format to save your output to.
After you have selected your file format, click OK in the Print dialog box. A Print to File
dialog box will appear enabling you to define the path and name of the file. For more
information on the Print to File dialog box, refer to Printing to a File (install)
If the Print to File radio button is deselected, this feature is deactivated.

OK Click the OK button to accept the settings and send your output to the selected printer or
file, depending on how you have set your options. Settings will be saved upon exit.

Cancel Click the Cancel button to dismiss the Print dialog box. Settings will not be saved upon
exit.

Help Click the Help button to access the online context sensitive help.

  

 Printing to a File
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The Print to File dialog box enables you to define a destination path and file name and
then output your information to the specified file. To use the Print to File dialog box,

Choose File > Print. The Print dialog box appears.1.

Select the Print to File option of the Print dialog box. Notice that when you select the2.
Print to File option, the Print to File section is activated enabling you to select a file
format.
Use the File Format drop-down list to select the desired file format. Options include3.
JPEG, GIF, PDF, Bitmap, and HP-GL/2.
Click OK in the Print dialog box. The Print to File dialog box appears.4.

Enter the file name for your output in the Selection field.5.
Click Save to save output on the file.6.

   

  

 Agilent EEsof Technical Support
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Agilent EEsof worldwide technical support is available Monday through Friday. The toll-free
North America hotline is open 6:00 am to 5:00 pm PT. Throughout Europe, the localized
Online Technical Support Centers are open during business hours, typically 8:30 am to
5:30 pm, local time; throughout Asia, the localized Customer Response Centers are open
during business hours, typically 9:00 am to 6:00 pm, local time.

The e-mail addresses for the various regions are listed below. However, for both the
regional e-mail addresses and local telephone numbers for more than 25 countries, please
refer to the Agilent EEsof Web site at

http://www.agilent.com/find/eesof-supportcontact

North America

Phone: 1 800 47 EEsof (473-3763) - Fax: 707-577-3511
e-mail: eesof_support@agilent.com

Europe: e-mail: eesof-europe_support@agilent.com
Japan: e-mail: eesof-japan_support@agilent.com
Korea: e-mail: eesof_korea@agilent.com
Asia: e-mail: eesof-asia_support@agilent.com

  

http://www.agilent.com/find/eesof-supportcontact
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 Installing Connection Manager Server
for UNIX and Linux
ADS 2011 release includes a Connection Manager Client on Unix and Linux; however the
Connection Manager Server must be installed on a 32-bit system with Windows XP or
Windows 2000.

For details, see Installing Connection Manager Server on Windows (instalpc).
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